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ВВЕДЕНИЕ
Цель издания — научить пользователей основным принципам работы с

одним из популярнейших графических редакторов Adobe Photoshop. Программа
многофункциональна и разнопланова, поэтому и популярна как среди нович-
ков, так и среди профессионалов. В данном учебно-методическом пособии рас-
сматриваются общие вопросы и основные этапы работы с программой. Авторы
сознательно сузили рамки изучаемого материала, концентрируя внимание на
вопросах, касающихся улучшения качества имеющегося иллюстративного ма-
териала. В издании для часто повторяющихся действий используются следую-
щие сокращения:

- 1щЛ — один щелчок левой клавишей мыши по указанному объекту
(выбор команды или нажатие на кнопку в диалоговом окне или на панели инст-
рументов);

- 1щП — один щелчок правой клавишей мыши по указанному объекту
(открывает контекстное меню, команды в котором меняются в зависимости
от того, в каком месте экрана монитора вы сделали щелчок левой клавишей
мыши);

– 2щЛ — двойной щелчок левой клавишей мыши по указанному объекту;
– Ctrl  +  D — одновременное нажатие клавиш Ctrl и D на клавиатуре

(сочетания такого типа часто называют «горячими клавишами»). Следует за-
помнить, что буквы, входящие в такие сочетания являются латинскими и рас-
полагаются в англоязычной раскладке клавиатуры;

– 1щЛ + Alt — держа нажатой клавишу Alt клавиатуры, сделать один
щелчок левой клавишей мыши;

– Menu > File > Save As > кнопка Save (Файл > Сохранить как > кнопка
Сохранить) — одним щелчком левой клавишей мыши (1щЛ) открыть меню
Файл, выбрать команду Сохранить как (1щЛ), а затем нажать кнопку Сохра-
нить (1щЛ).

Большинство пользователей работают с англоязычной версией програм-
мы, так как при русификации безотказность работы программы резко падает из-
за ошибок, вносимых в программный код. В связи с этим авторы сначала будут
давать английское название команды, параметра и т. д., а затем в скобках его
русский аналог, например Rotate Canvas (Поворот холста). Названия файлов и
элементов интерфейса программы (названия палитр, кнопок, команд, вкладок,
флажков, элементов диалогового окна и т. д.) выделены полужирным шрифтом.
Вводимые впервые термины, важные советы или тонкости работы с програм-
мой выделены полужирным курсивом. Такие графические обозначения помо-
гают читателю быстро ориентироваться в тексте. Программа развивается, вы-
ходят новые обновлённые версии: от Photoshop 6 к Photoshop 8 (называемая
чаще Photoshop CS) и Photoshop 9 (Photoshop CS2). В разделах программы,
представленных в этом издании, графический редактор не претерпел сущест-
венных изменений, поэтому данным учебно-методическим пособием можно
пользоваться при работе со всеми версиями этой программы. Иллюстративный
материал сделан на основе программы Photoshop CS (англоязычной версии).
Отличия от предыдущих версий будут оговариваться особо.
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ГЛАВА 1. НАЧАЛО РАБОТЫ С ГРАФИЧЕСКИМ
РЕДАКТОРОМ PHOTOSHOP

НАЗНАЧЕНИЕ И ОСНОВНЫЕ ТЕРМИНЫ

Программа Photoshop (читается «Фотошоп») — графический редактор
для обработки растровых изображений.

На практике чаще говорят об обработке изображения, включающей цве-
товую и тоновую коррекцию, изменение размера изображения и его цветового
режима, внесение в изображение или в его часть всевозможных световых эф-
фектов, создание коллажей (фотомонтажа) и многое другое.

Цифровые изображения бывают двух основных типов: растровые и век-
торные. Растровые изображения представляют собой прямоугольную сетку то-
чек (пикселов), а векторные состоят из контуров — линий, которые запомина-
ются в графическом файле в виде математических формул.

Растровые изображения — это изображения в виде набора точек
(пикселов), имеющих различный цвет. В файле запоминается цвет каждой точ-
ки и её расположение на изображении. Таким образом без искажений переда-
ются мелкие детали и оттенки цветов, однако размер файла в мегабайтах резко
увеличивается.

Количество пикселов на единицу длины называется разрешением
(resolution). Чем больше разрешение, тем размер файла также больше.

В повседневной жизни мы обычно называем документом текстовую ин-
формацию. В данной же программе документом называется любой графиче-
ский файл, то есть любое изображение в электронном виде.

ЗАПУСК ПРОГРАММЫ PHOTOSHOP

Photoshop, как и любая другая программа, инсталлированная на вашем
компьютере, открывается стандартным образом: 1щЛ по кнопке Пуск, распо-
ложенной в нижнем левом углу панели задач (серая строчка внизу на экране
монитора), затем следует выбрать команду Программы в главном меню опера-
ционной системы и в открывшемся подменю 1щЛ на команде Adobe
Photoshop. При этом программа будет запущена, а на экране появится окно
прикладной программы или приложения (иногда говорят «интерфейс прило-
жения»). При открытии программы файл не создаётся.

ОТКРЫТИЕ ДОКУМЕНТА В ПРОГРАММЕ PHOTOSHOP

Для открытия существующего документа необходимо 1щЛ на меню File
(Файл), выбрать команду Open (Открыть) и в открывшемся диалоговом окне
щелкнуть на нужном логическом диске, затем папке и имени файла, нажать
кнопку Открыть.

Это объяснение можно записать кратко следующим образом: Menu  >
File > Open (Файл > Открыть) > найти в долговременной памяти файл > кнопка
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Открыть. Далее описания пути для осуществления того или иного действия
будут отображаться в таком виде.

Результат — открытие существующего изображения в окне прикладной
программы (рис. 1).

Рис. 1. Интерфейс окна прикладной программы Photoshop:
1 — строка заголовка; 2 — строка меню; 3 — кнопки управления окном программы; 4 — панель ин-
струментов; 5 — панель параметров выбранного инструмента; 6 —  набор плавающих палитр
(11 штук в стопках по две или три); 7 — рабочая область программы; 8 — окно документа; 9 — стро-
ка заголовка документа (документ на рисунке не занимает всё окно программы); 10 — панель
Brushes (Кисти) (для Photoshop 6); 11 — горизонтальная полоса прокрутки; 12 — вертикальная поло-
са прокрутки; 13 — строка состояния; 14 — текстовое поле Масштаб

ОКНО ПРИКЛАДНОЙ ПРОГРАММЫ PHOTOSHOP

Окно Photoshop, как и окно любого приложения (прикладной програм-
мы), содержит вдоль верхней границы строку заголовка, где отображено имя
программы. В правой части строки заголовка расположены кнопки управления
размерами окна , позволяющие свернуть, уменьшить до половины эк-
рана монитора и закрыть окно. Это стандартные манипуляции с окнами в опе-
рационной системе Windows.

В левом углу строки заголовка находится пиктограмма Photoshop откры-
вающая оконное меню приложения, которое дублирует кнопки, показанные
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выше. Вид пиктограммы зависит от версии программы и от установленного на
вашем компьютере «программы-просмотрщика» графических файлов (вьюера).
Обычно на ПК предустановлен вьюер ACDSee, который отображает файлы

программы Photoshop в формате PSD .
Ниже строки заголовка находится строка главного меню программы,

каждый пункт которой есть заголовок меню и при 1щЛ на каком-нибудь из них
открывается список команд. Меню называется главным, потому что в програм-
ме ещё есть и другие меню: меню палитр и контекстные меню.

Ниже строки главного меню располагается панель параметров (опций)
инструментов. Внешний вид этой панели меняется в зависимости от того, ка-
кой инструмент был выбран для работы с изображением.

Сама панель инструментов является «плавающей» и по умолчанию на-
ходится вдоль левого края окна программы. Инструмент — кнопка на этой
панели, вызывающая выполнение какой-либо важной функции программы.
Существует несколько видов инструментов: рисования, редактирования, вос-
становления, заливки и другие, причём большинство из них объединены в груп-
пы. Некоторые инструменты будут рассмотрены в этом издании ниже.

Выбор инструмента осуществляется 1щЛ на соответствующей кнопке.

При этом кнопка западает (её цвет меняется с серого  на белый ). Это
означает, что инструмент активизирован и с ним можно работать. Активизация
инструмента изменяет вид панели параметров (параметры подстраиваются под
инструмент), а также вид курсора мыши.

В правом нижнем углу большинства инструментов имеется маленький

треугольник (пример для инструмента Clone Stump (Штамп ) (рис. 2).

Рис. 2. Группа инструментов Stump (Штамп)

Он указывает на то, что тут скрыта целая группа схожих инструментов.
При нажатии левой клавишей мыши на кнопку открывается меню данной груп-
пы инструментов, из которого можно выбрать нужный. Рядом с пиктограммой
инструмента (Tool) находится его название и указана «горячая клавиша», от-
крывающая быстрый доступ к данной группе инструментов. В данном случае
это клавиша S на клавиатуре.

Чтобы не открывать меню группы инструментов, но переключиться на
другой инструмент данной группы, следует:

- первый способ: 1щЛ на кнопке инструмента, держа нажатой клавишу
Alt клавиатуры (1щЛ + Alt);

- второй способ: нажать «горячую клавишу» группы инструментов при
удержании Shift (для данного примера S + Shift).
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При этом циклически переключаются инструменты группы, доступные в
данном раскрывающемся меню. Для изображённого примера это будут инстру-
менты Clone Stump (Штамп) и Pattern Stump (Мозаичный штамп).

Ниже рабочей области окна программы находится строка состояния,
которая содержит служебную информацию и сообщения пользователю о воз-
можных действиях в данный момент. В левом углу этой строки находится тек-
стовое поле масштаба окна документа. Набранный в этом поле масштаб (в
процентах) программа сразу же воспроизведёт. Это один из методов масштаби-
рования изображения.

Вдоль правого края окна программы расположен набор из 11 палитр.
Если их нет в окне программы, их можно легко выставить на экран: Menu  >
Windows > Show (название палитры) (Окно > Показать (название палитры)).
Таким же образом их можно убрать с рабочей области программы.

Палитры — это особые объекты графической программы, имеющие оп-
ределённую структуру. В каждой палитре обязательно есть строка управления,
ярлычок, кнопка доступа к меню, рабочая область и строка управляющих кно-
пок (рис. 3).

Рис. 3. Структура палитры на примере палитры Channels (Каналы):
1 — строка управления; 2 — ярлычок палитры; 3 — кнопка доступа к меню палитры; 4 — рабочая
область палитры; 5 — строка управляющих кнопок палитры

Строка управления необходима для легкого перемещения палитры по
экрану монитора: 1щЛ на строке управления и, удерживая кнопку, потянуть в
нужную сторону.

Все палитры в программе являются плавающими.
В правом углу строки управления находятся две кнопки: кнопка Свер-

нуть палитру  и кнопка Закрыть палитру .
Панели сгруппированы по две-три в стопки (каскадом: когда одна распо-

ложена за другой, почти полностью перекрывая друг друга), чтобы занимать
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меньше места в окне программы. Чтобы увидеть нужную панель, необходимо
сделать 1щЛ на её ярлычке. Палитра выйдет на передний план в стопке.

Правее ярлычков палитр находится кнопка доступа к меню палитры

: 1щЛ на ней открывает собственное меню палитры, часто более обширное
и подробное, чем главное меню для данной функции программы. Об этом сле-
дует помнить и чаще использовать его в работе.

Рабочая область палитры различна для разных палитр в соответствии с
их функцией. На элементах палитры 1щП открывает контекстное меню, изме-
няющееся в зависимости от того, где вы щёлкнули.

Под рабочей областью находится строка управляющих кнопок палит-
ры. Кнопки предназначены для выполнения наиболее частых команд и различ-
ны для каждой палитры.

Ещё одна палитра Brushes (Кисти) спрятана на панели параметров в виде

кнопки . Она появляется только при выборе инструмента, исполь-
зующего кисти (brushes).

Эта кнопка сложная, то есть состоящая из двух. Если нажать левую кноп-

ку , то будет использоваться кисть (кончик инструмента) того размера и ви-
да, которые указаны на кнопке (круглая кисть размером (кеглем) в 21 пункт с

размытием по краям). Если нажать правую кнопку , раскрывается палитра
Brushes (Кисти), в которой можно выбрать другую, создать новую кисть и за-

дать её параметры, а также через кнопку доступа к меню палитры  име-
ется доступ к собственному меню палитры. Понятие о кистях и методах их соз-
дания и изменения будут рассмотрены ниже в главе 5.

Внутри окна программы находится окно документа. Если документ не
помещается в это окно (рис. 1), справа и снизу от рабочей области документа
находятся полосы прокрутки для быстрого перемещения по изображению, ви-
димому в окне документа. Окно документа можно перемещать внутри окна
программы, потянув за строку заголовка.

В нижней части панели инструментов находится группа кнопок измене-

ния размеров окна документа :

- Standard Screen Mode (Стандартный экранный режим ). Про-
грамма и документ (изображение) открываются в собственных окнах. Все эле-
менты окна программы видны на экране. Этот режим включен по умолчанию.

- Full Screen Mode with Menu Bar (Полноэкранный режим со строкой

меню ). Необходим в том случае, если документ не помещается в стандарт-
ном окне программы. В этом режиме палитры и все другие элементы окна про-
граммы, кроме строки меню, панели инструментов и панели параметров вы-
бранного инструмента, исчезают с экрана.
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- Full Screen Mode (Полноэкранный режим ) отличается от преды-
дущего только тем, что с экрана исчезает и строка меню.

- Переход между этими режимами: 1щЛ на нужной кнопке на панели
инструментов или нажатием «горячей клавиши» F до тех пор, пока не активи-
зируется нужный режим.

ГЛАВА 2. РАБОТА С ФАЙЛАМИ
(ДОКУМЕНТАМИ) PHOTOSHOP

СОЗДАНИЕ И ОТКРЫТИЕ ДОКУМЕНТА

СОЗДАНИЕ НОВОГО ДОКУМЕНТА

Выше уже рассказывалось, как начать работу с программой. Для создания
документа (изображения) необходимо применить команду New (Новый доку-
мент). Её смысл аналогичен предложению программе положить перед вами
лист чистой бумаги для создания на нём изображения. Без этого действия вам
не удастся начать работу с ней. Чистый лист (подложка изображения) может
быть трёх видов: белого (White), цвета фонового (Background Color) или про-
зрачного слоя (Transparent), что и следует задать при создании.

Для создания нового документа необходимо: Menu > File > New (Файл >
Новый) > откроется диалоговое окно New (Новый документ), в котором нужно
задать параметры изображения > кнопка ОК. Рассмотрим диалоговое окно New
(Новый документ) (рис. 4).

Рис. 4. Вид диалогового окна New (Новый документ)

В текстовое поле Name (Имя документа) обязательно следует ввести за-
головок для будущего документа. Ниже этого поля вводятся размеры докумен-
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та в ширину (поле Width) и высоту (поле Height) в выбранных вами единицах
(обычно в пикселах (pixels)), а также разрешение (поле Resolution), опреде-
ляющее качество будущего изображения и измеряемое в пикселах на единицу
длины (сантиметр (cm) или дюйм (inch)). Один дюйм равен 2,54 см. Кроме это-
го, в этом окне также выбирается крайне важная характеристика изображения
Color Mode (Цветовой режим), который определяет цветовую модель, с помо-
щью которой будут создаваться цвета спектра, о чём более подробно будет рас-
сказано ниже в главе 3.

Раскрывающийся список Background Contents (Содержимое подложки)
позволяет выбрать цвет подложки будущего документа: белый (White), цвет
фонового слоя (Background Color) или прозрачный слой (Transparent).

ОТКРЫТИЕ СУЩЕСТВУЮЩЕГО ДОКУМЕНТА

Если изображение у вас уже есть на винчестере, флеш-драйве («флешке»)
или CD-диске, надо применить команду Open (Открыть): Menu > File > Open
(Файл > Открыть). При этом появится диалоговое окно, в котором вам будет
предложено указать имя файла (документа) и папку, в которой он находится.

В поиске нужного файла в этом же диалоговом окне можно просмотреть
содержимое любой папки или логического диска, доступного компьютеру в

раскрывающемся списке Папка .
Поиск осуществляется следующим образом: 1щЛ на поле Папка откроет

дерево папок, в котором 2щЛ на нужном логическом диске откроет содержимое
диска, 2щЛ на нужной папке и т. д., пока не войдёте в папку, в которой нахо-
дится нужный вам файл. Когда файл найден, следует щёлкнуть по нему (1щЛ)
для его выделения и нажать кнопку Открыть в этом диалоговом окне. На эк-
ране появится нужный вам документ, если программа поддерживает формат
данного файла.

ФОРМАТ ФАЙЛА

Формат файла — метод записи информации (в данном случае изобра-
жения) в файл данного вида. Каждый формат имеет своё расширение. Напом-
ним, что имя файла состоит из трёх частей: собственно имени, точки и расши-
рения (3 или 4 латинские буквы), характеризующие формат и указывающие
операционной системе (ОС) какая программа и как может прочитать и отобра-
зить данный файл.

Файлы программы Photoshop имеют расширение PSD (.psd — PhotoShop
Document). Как говорилось выше, обычно на ПК предустановлен вьюер
ACDSee, который файлы программы Photoshop показывает в виде листа бумаги

с изображение глаза на нём и указанием формата PSD . Если же «про-
граммой-просмотрщиком» графических файлов выбрана сама программа
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Photoshop, то он устанавливает для этих файлов ярлычок в виде листа бумаги с

зеленовато-оранжевым пером и буквами PSD .
Графических форматов очень много (более 50), поэтому по расширению

часто называют и форматы. Так, программа Photoshop создаёт файлы графиче-
ского формата PSD.

ОТКРЫТИЕ ДОКУМЕНТА ДРУГИМИ СПОСОБАМИ

Можно открыть документ и другими способами:
- по команде Menu > File > Open Recent (Файл > Открыть последний)

открывается список имён нескольких недавно открывавшихся документов.
- команда Menu > File > Browse (Файл > Браузер) открывает Обозрева-

тель файлов (File browser) , который позволяет увидеть миниатюрные изобра-
жения (т. н. этикетки (thumbnails)) графических файлов, расположенных в
текущей папке. В таком случае можно искать файл не по имени, а по этикетке,
что при большом количестве изображений в одной папке очень удобно.

МАНИПУЛЯЦИИ С ИЗОБРАЖЕНИЕМ

ПЕРЕМЕЩЕНИЕ ПО ДОКУМЕНТУ

Как указывалось выше, у правой границы и внизу рабочей области листа
располагаются вертикальная и горизонтальная полосы прокрутки. На каждой из

них находится бегунок (имеет вид пустого квадратика  или прямоугольни-
ка), при перетаскивании которого по полосе прокрутки изображение также
передвигается.

Кроме бегунка можно использовать и кнопки со стрелками (в виде тре-

угольников, указывающих направление перемещения , , , )  в
углах полос прокрутки. При непрерывном нажатии левой кнопки мыши на та-
кую кнопку видимая в окне документа часть изображения смещается в сторону,
указанную на кнопке со стрелкой.

Инструмент Hand (Рука ) на панели инструментов также позволяет
двигать изображение в окне, чтобы увидеть те части, которые не поместились в
окне. Инструмент полезен при работе с увеличенным масштабом изображения.
Чтобы передвинуть изображение, выберите (1щЛ) инструмент Hand (Рука),
нажмите левую кнопку мыши и, удерживая её, передвиньте (перетащите) мышь
в нужном направлении.

ИЗМЕНЕНИЕ РАЗМЕРОВ ИЗОБРАЖЕНИЯ

Иногда есть необходимость уменьшить или немного увеличить изобра-
жение. Для этого требуется выполнить команду Menu  >  Image  >  Image  Size
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(Изображение > Размер изображения). Откроется диалоговое окно Image Size
(Размер изображения) (рис. 5).

Рис. 5. Вид диалогового окна Image Size (Размер изображения)

Убедитесь, что флажок Resample Image (Отслеживать изменения) уста-
новлен, чтобы не потерять, в случае неудачного изменения, первоначальный
файл. Для того, чтобы сохранить соотношение ширины и высоты изображения,
не снимайте флажок Constrain Proportions (Сохранять пропорции).

В группе Pixel Dimensions (Размеры в пикселах) имеются параметры
Width (Ширина) и Height (Высота). О соотношении ширины и высоты свиде-
тельствует пиктограмма звена цепи, расположенная справа от полей ввода зна-
чений. Размеры изображения устанавливаются в пикселах или в процентах от
исходного размера.

В этом же окне есть возможность изменить размеры и самого докумен-
та — группа параметров Document Size (Размер документа). В этой группе есть
и поле установки разрешения (Resolution).

Чтобы восстановить исходные установки окна Image Size (Размер изо-
бражения), нажмите клавишу Alt и одновременно щелкните на кнопке Reset
(Восстановить).

ПОВОРОТЫ ИЗОБРАЖЕНИЯ

Для поворотов изображения относительно его исходного положения сле-
дует применить команду Menu > Image > Rotate Canvas (Изображение > По-
ворот холста), а далее выбрать один из предложенных способов поворота
(рис. 6).
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Рис. 6. Вид подменю Rotate Canvas (Повернуть холст) меню Image (Изображение)

В меню предусмотрены повороты на 180°, 90° по часовой (90° CW) и 90°
против часовой стрелки (90° CCW). Выполнение команды Menu > Image >
Rotate Canvas > Arbitrary (Изображение > Поворот холста > Произвольно)
даёт возможность установить произвольный угол поворота холста.

В этом же подменю Rotate Canvas (Поворот холста) находятся две ко-
манды, начинающиеся со слова Flip… (Перевернуть…), которые приводят к
зеркальному отражению изображения. Выполнение команды Menu > Image >
Rotate Canvas > Flip Canvas Horizontal (Изображение > Поворот холста > Пе-
ревернуть холст горизонтально) отражает изображение в горизонтальном на-
правлении, а команда Flip Canvas Vertical (Перевернуть холст вертикально) —
в вертикальном. В меню Photoshop 6 эти команды называются: Flip Horizontal
(Перевернуть горизонтально) и Flip Canvas Vertical (Перевернуть вертикаль-
но), без слова Canvas (Холст).

ИЗМЕНЕНИЕ МАСШТАБА ИЗОБРАЖЕНИЯ

Порой приходится обрабатывать довольно маленькие изображения или
редактировать слишком мелкие фрагменты рисунка. Чтобы результаты были
точны, а работать с документом было удобно, воспользуйтесь возможностью
изменения масштаба изображения.

Увидеть, какой масштаб установлен на данный момент, можно в трёх
местах программы: 1) в строке заголовка документа в скобках; 2) в левом углу
строки состояния редактора (текстовое поле Масштаб), а также 3) на палитре
Navigator (Навигатор) (на рисунке 1 во всех трёх местах указано одно и то же
значение масштаба — 50 %).
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Масштаб представления изображения никак не влияет на размер изобра-
жения при сохранении или выводе на печать.

Для изменения масштаба изображения в Photoshop предусмотрено не-
сколько способов. Например, можно воспользоваться инструментом Zoom (Лу-

па ) на панели инструментов. Кроме того, можно изменить масштаб, меняя
значение в текстовом поле в левом углу строки состояния редактора. Однако
при этом способе размеры окна остаются без изменения.

Наиболее удобна возможность изменения масштаба изображения на па-
литре Navigator (Навигатор) (рис. 7).

Рис. 7. Вид палитры Navigator (Навигатор)

Введите новое значение масштаба в процентах или в виде отношения (на-
пример, 1:1 или 1:4) в левом нижнем углу окна изображения и нажмите клави-
шу клавиатуры Enter. Если необходимо сохранить данное поле активным, вос-
пользуйтесь сочетанием клавиш Shift  + Enter. Если сделать 1щЛ на кнопке
Zoom out (Уменьшить масштаб ) внизу палитры в строке управляющих
кнопок, масштаб видимой части изображения уменьшится. Если же надо уве-
личить — 1щЛ на кнопке Zoom in (Увеличить масштаб видимой части изобра-

жения ). Перемещая ползунок масштабирования, находящийся на шкале
между этими кнопками, можно плавно изменить масштаб видимой части
изображения.

Видимая в окне документа область на панели Navigator (Навигатор) бу-
дет выделена прямоугольником с красной границей-рамкой. Если подвести

курсор мыши на этот прямоугольник (рис. 7), курсор примет вид руки  и
появится возможность перетаскивать рамку или прямоугольник, что приведет к
перемещению видимой части изображения в окне без изменения его размера.

ОТМЕНА ОШИБОЧНЫХ ДЕЙСТВИЙ

Если нужно отменить последнее действие, надо выполнить следующие
действия: Menu > Edit > Undo (Правка > Отменить), или использовать «горя-
чую клавишу» Ctrl + Z. Чтобы заново выполнить отменённое действие: Menu >
Edit > Redo (Правка > Повторить), или снова та же «горячая клавиша» Ctrl + Z.
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Команда Undo (Отменить) — самый простой способ восстановить графи-
ческий файл в предыдущее состояние, но только в самое последнее.  Часто же
необходимо возвратить документ к более ранним шагам работы. Для этого
применяется палитра History (Протокол) (рис. 8).

Если палитра History (Протокол) отсутствует, выставьте её в окно про-
граммы: Menu > Window > Show History (Окно > Показать палитру Протокол).

Каждое действие в палитре History (Протокол) отображается в виде стро-
ки с наименованием действия. На рисунке 8 мы видим только одно действие
для документа Кубок2.bmp — открытие документа (Open).

Чтобы отменить действие, достаточно сделать 1щЛ на строчке, соответ-
ствующей отменяемому действию (выделить её), и перетащить эту строку (не

отпуская кнопку мыши) на кнопку Удалить (мусорное ведро  в Photoshop
CS или  в Photoshop 6), находящуюся в строке управляющих кнопок ниже
рабочей области палитры.

Рис.8. Вид палитры History (Протокол)

Количество запоминаемых шагов может быть задано в диалоговом окне
Preferences (Установки), которое можно вызвать следующим образом: Menu >
Edit > Preferences > General (Правка > Установки > Общие). Откроется диало-
говое окно Preferences (Установки) и в поле History States (Предыдущие со-

стояния или шаги ) ввести требуемое число шагов, которые будут
доступны через палитру History (Протокол). Выбираемых по умолчанию 20
шагов вполне достаточно, так как увеличение числа шагов замедляет работу
программы из-за использования на запоминание предыдущих состояний доку-
мента бóльшего объёма оперативной памяти.

СОХРАНЕНИЕ ДОКУМЕНТА И ВЫХОД ИЗ ПРОГРАММЫ

СОХРАНЕНИЕ ДОКУМЕНТА

При выключении питания компьютера содержимое оперативной памяти
утрачивается, а значит, и созданный вами файл (документ) будет уничтожен.
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Чтобы этого не произошло, следует сохранить изображение: Menu > File
(Файл) > выбрать команду Save (Сохранить) или Save As (Сохранить как). Рас-
смотрим разницу.

Команду Save As (Сохранить как) следует обязательно использовать в
следующих случаях: 1) если документ сохраняется в первый раз (первичное со-
хранение); 2) если вы хотите переименовать его или переложить в другую пап-
ку (на другой логический диск).

При выборе этой команды открывается диалоговое окно Save As (Сохра-
нить как), в котором будет предложено указать имя документа (набрать в поле
ввода Name (Имя файла)) и место на логическом диске (винчестере, флешке,
дискете или CD-диске) с указанием папки для сохранения изображения.

Указание нового места сохранения документа осуществляется с помо-
щью: 2щЛ на поле Папка  или на кнопке раскры-
вающегося списка , после чего открывается дерево папок, в котором 2щЛ на
нужном логическом диске откроет содержимое диска, затем 2щЛ на нужной
папке и т. д., пока не войдёте в папку, в которой надо сохранить ваш документ.

Обязательно войдите в ту папку, в которой хотите сохранить ваш
документ! Проверьте, чтобы в поле Format (Тип файла) был указан нужный
вам формат файла. Это очень важно, так как сохранённое не в том формате изо-
бражение может потерять цвета (излишнее сжатие), возможность повторного
редактирования в Photoshop, слои, каналы и другое. Выбрав формат, следует
нажать кнопку Сохранить в этом диалоговом окне.

Только в формате PSD (собственный формат программы Photoshop с рас-
ширением .psd) полностью сохраняются все настройки программы: поддержка
слоёв, цветовых и альфа-каналов, контуров и масок. Если вы собираетесь про-
должить работу с данным файлом в Photoshop, то сохранять документ следует
исключительно в этом формате. Многослойные (содержащие цветовые каналы)
изображения могут быть сохранены только в форматах Photoshop PSD,
Photoshop PDF и Advanced TIFF (.tiff).

Если слои не нужны, то перед сохранением следует свести в один все
слои, то есть превратить изображение из многослойного в однослойное:
Menu > Layer > Flatten Image (Слой > Свести все слои). Слои не будут рас-
сматриваться в издании, так как это выходит за рамки, очерченные для данного
учебно-методического пособия.

Изображения, которые вы хотите выставить в виде фона Рабочего стола
ОС, должны быть сохранены в формате BMP (Bitmap — точечный рисунок,
имеющий расширение .bmp).

Изображения для печати на цветном принтере или в фотоателье лучше
сохранять в форматах TIF (.tif), Advanced TIFF (.tiff), Enhanced PostScript (EPS)
(.eps) и TGA (формат фирмы Targa, имеющий расширение .tga), так как эти
форматы сохраняют богатую цветовую гамму, а искажения цвета минимальны.

Команда Save (Сохранить), «горячая клавиша» Ctrl + S, применяется, ес-
ли были внесены изменения в документ и нужно сохранить его под тем же име-
нем и в той же папке, где он и был до его открытия (вторичное сохранение).
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В связи с частыми сбоями в электрической сети и большими размерами
графического файла, чтобы не потерять обработанную информацию безвоз-
вратно, рекомендуется в процессе работы с изображением периодически со-
хранять его.

Лучше сохранять после обработки или через каждые 5 минут работы
(Ctrl + S). Сохраняется открытый документ под тем же самым именем. Поэто-
му, если вы существенно изменяете открытое в программе изображение,
лучше сразу переименовать его и сохранить под новым именем в нужном
вам месте на винчестере, и только затем начать ваши изменения его содержа-
ния. Также в диалоговом окне Save As (Сохранить как) можно установить фла-
жок Save As a Copy (Сохранить в виде копии ), чтобы сохранить
файл как копию и продолжить работу с оригиналом.

Для восстановления последней сохранённой версии документа выполня-
ется команда: Menu > File > Revert (Файл > Обратить).

Изображения для Web-сайтов обычно сохраняются в следующих форма-
тах: GIF (малое количество цветов — всего 216), JPEG (более полноцветный
формат, но очень сильное сжатие сопровождается потерей качества) и PNG (два
варианта: PNG-8 (восьмибитовый цвет) и PNG-24 (24-битовый цвет). Преиму-
щество этих форматов — компактность.

Наиболее предпочтителен формат PNG-24 как обладающий наиболее бо-
гатой цветовой гаммой. Проще всего сохранять их командой: Menu > File >
Save for Web (Файл > Сохранить для Web). В группе Settings (Настройки) в
раскрывающемся списке Optimised file format (Оптимальный формат файла)
выберите нужный — изображение будет пересчитано в этот формат («оптими-
зировано под этот формат»). Если вид документа, оптимизированного для
Web-изображения, вас устраивает, нажмите кнопку OK.

ПЕРЕХОД К РАБОТЕ С ДРУГИМИ ДОКУМЕНТАМИ

После сохранения изображения его следует закрыть: Menu > File > Close
(Файл > Закрыть), а затем перейти к другому документу, снова выбирая коман-
ду New (Новый документ) или Open (Открыть) (см. выше).

Если вы не закрыли предыдущий графический файл, то при создании или
открытии нового, программа покажет новый документ в новом окне документа
внутри открытого окна приложения Photoshop. Вы можете работать одновре-
менно с обоими окнами документов, что очень удобно для создания коллажа
(составного изображения из фрагментов разных изображений, называемого
также фотомонтажём).

Переход из одного окна документа в другое: 1щЛ по строке заголовка
нужного документа (если документы не занимают всё окно программы) или в
Menu > Window (Окно) (внизу этого меню перечислены имена всех открытых
документов, указан их масштаб и цветовой режим). Один щелчок на имени
нужного изображения сразу выводит его окно на экран.

Одновременно по умолчанию можно работать с документами максимум в
4 окнах документов, но можно изменить это количество в диалоговом окне
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Preferences (Установки): Menu > Edit > Preferences > Saving Files (Правка >
Установки > Сохраняемые файлы). В поле Recent file list contains (Список
файлов сейчас содержит ) ввести требуемое число файлов, которые мо-
гут быть открыты одновременно.

ВЫХОД ИЗ ПРОГРАММЫ

Это возможно тремя способами:
- Menu > File > Exit (Файл > Выход);
- «горячая клавиша» Ctrl + Q;
- кнопка Закрыть (косой крест ) — в правом углу строки заголовка

окна прикладной программы.
Первые два способа предпочтительнее с точки зрения целостности про-

граммы. После этих действий программа закроется, то есть прекратит свою ра-
боту, о чём говорит исчезновение кнопки Adobe Photoshop с
панели задач Рабочего стола операционной системы.

ЭТАПЫ РАБОТЫ С PHOTOSHOP

Когда приступаешь к изучению любой программы, полезно воспользо-
ваться правилом (алгоритмом действий), которое называется этапами работы.
Правило (алгоритм) указывает на последовательность действий в этой про-
грамме, которые не позволяют потерять уже обработанные данные или сделан-
ную работу. Когда вы освоите программу хорошо, то сможете редактировать
изображение по алгоритму, приемлемому для вас. Пока же следует запомнить
алгоритм, предлагаемый в этом издании.

Этапы работы с графическим редактором Photoshop по коррекции
изображения:

1. Начальный этап работы:
- открытие программы;
- создание изображения (если не существует) или его открытие (если

оно уже есть на винчестере, флэш-драйве или дискете).
2. Основная работа по коррекции изображения:

- выбор цветового режима;
- тоновая коррекция документа в целом;
- цветовая коррекция изображения в целом;
- локальная коррекция;
- исправление плохой резкости изображения;
- удаление пятен и царапин.

3. Завершающий этап:
- сохранение документа в выбранном вами формате;
- выход из программы.
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Выше уже были рассмотрены пункты начального и завершающего этапов
работы. Далее будет представлен основный этап работы — методы коррекции
изображения.

Это издание не затрагивает вопросов рисования, заливки, добавления тек-
ста, создания выделенных областей и масок, работу в слоях и создание колла-
жей, чтобы данное учебно-методическое пособие не разрослось до размеров
книги и не вышло за рамки объявленной в названии темы. Выражаем надежду,
что, разобравшись с коррекцией, читатели пойдут дальше и уже самостоятель-
но изучат вышеперечисленные возможности программы.

ГЛАВА 3. ОСНОВНЫЕ ЦВЕТОВЫЕ ПОНЯТИЯ В PHOTOSHOP

ЦВЕТОВОЙ ОХВАТ

Количество цветовых оттенков безгранично. Глаза человека, некоторых
животных, а также оборудование (сканер), материалы (фотопленка) восприни-
мают цвета. Офсетная машина, монитор, фотобумага — воспроизводят.

В каждом из этих процессов участвует большое количество цветов, но
меньше всего диапазона. Так, глаз не воспринимает цвета ультрафиолета и
инфракрасного излучения. Фотоаппарат не чувствителен к очень темным от-
тенкам. Традиционная офсетная печать не передает очень светлые и яркие тона.
Диапазон цветов, который может быть воспроизведен, зафиксирован или опи-
сан каким-либо способом, называется цветовым охватом.

Цветовой охват монитора, офсетной машины и глаза разный, причём у
глаза он наибольший. Часть из того, что воспринимает глаз, может передать
монитор. Но на экране нельзя точно передать, например, чистый голубой или
жёлтый цвет. При полиграфическом исполнении совсем не передаются цвета,
составляющие которых имеют очень низкую плотность.

Разность цветовых охватов устройств вывода и человеческого глаза пред-
ставлена схемой, приведенной на рис. 9. Каждый из охватов может быть выра-
жен моделью цвета.

Рис. 9. Различия в цветовых охватах различных устройств и человеческого глаза:
1 —  человеческий глаз (модель Lab); 2 —  монитор (модель RGB); 3 — цветной принтер (модель
CMYK)

1

2

3
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ЦВЕТОВЫЕ МОДЕЛИ

Цветовая модель — это математическое описание цветовых оттенков
изображения для превращения его в цифровую форму. Их существует несколь-
ко, но ни одна из моделей не считается идеальной. Устройство моделей одина-
ково: в каждой из них принято несколько базовых компонентов, каждый из ко-
торых вносит вклад в создание определённого цвета.

Базовые компоненты модели называются каналами. Цвета, которые
можно описать, используя данную модель, входят в её цветовой охват, то есть
эти цвета образуют цветовое пространство модели. Все модели имеют
различный цветовой охват. Самые известные цветовые модели: 1) RGB;
2) CMYK; 3) Lab; 4) HSB.

ЦВЕТОВАЯ МОДЕЛЬ RGB

Цветовая модель RGB (читается «Эр-Же-Би») описывает излучаемые
цвета. Она подходит для описания цветов, отображаемых мониторами, полу-
чаемых сканерами и цветовыми фильтрами, но не печатающими устройствами.

Цвет в модели RGB представляется как сумма трёх базовых цветов: крас-
ного (Red), зелёного (Green) и синего (Blue). При восприятии цвета человеком
именно они непосредственно воспринимаются глазом. Из первых букв англий-
ских названий этих цветов составлено название модели.

Остальные цвета представляют собой смешение трёх базовых в разных
соотношениях. Цвета этого типа называются аддитивными (полученными сло-
жением цветов). При сложении (смешении) двух лучей основных цветов ре-
зультат оказывается светлее, чем отдельные составляющие. Модель RGB — это
трёхканальная цветовая модель.

В модели RGB каждый базовый цвет характеризуется яркостью (интен-
сивностью), которая может принимать 256 дискретных значений от 0 до 255.
Поэтому можно смешивать цвета в различных пропорциях, варьируя яркость
каждой составляющей. Таким образом, можно получить 256 ´ 256 ´ 256 =
16 777 216 цветов.

Каждому цвету можно сопоставить код, который содержит значения яр-
кости трёх составляющих. Используются десятичное и шестнадцатеричное
представления кода.

Десятичное представление — это тройка десятичных чисел, разделённых
запятыми. Первое число соответствует яркости красной составляющей, второе -
зелёной, а третье — синей.

Код цвета в шестнадцатеричном представлении имеет вид ОхХХХХХХ.
Префикс ох указывает на шестнадцатеричное число. За префиксом следуют
шесть шестнадцатеричных цифр (0, 1, 2, ..., 9, А,  В,  С,  D,  Е,  F). Первые две
цифры — шестнадцатеричное число, представляющее яркость красной состав-
ляющей, вторая и третья пары соответствуют яркости зеленой и синей состав-
ляющих (рис. 10а).
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а б
Рис. 10. Схематическое изображение цветовых кругов, соответствующих

аппаратно-зависимым цветовым моделям: а — RGB; б — CMYK

Если все составляющие имеют максимальную яркость (255, 255, 255 —
в десятичном представлении, ОхFFFFFF — в шестнадцатеричном представле-
нии), получается белый цвет. Минимальная яркость (0,  0,  0 или Ох000000)
соответствует чёрному цвету.

Смешение красного, зелёного и синего цветов (с одинаковой яркостью)
дает шкалу из 256 оттенков (градаций) серого цвета — от чёрного до белого.

Изображения в оттенках серого ещё называют полутоновыми изобра-
жениями.

Базовые цвета смешиваются следующим образом (рис. 10а):
-красный и зелёный при максимальной яркости дают желтый цвет.

Уменьшение яркости красного изменяет результирующий цвет в сторону зеле-
новатого, а уменьшение яркости зелёного делает цвет оранжевым;

- зелёный и синий при максимальной яркости дают голубой. Изменяя
пропорцию яркостей, можно получить 65 000 оттенков голубого — от небесно-
го до тёмно-синего;

-красный и синий при максимальной яркости дают пурпурный или фио-
летовый. Уменьшение яркости синего сдвигает цвет в сторону розового, а
уменьшение красного — в сторону пурпурного.

Поскольку яркость каждой из базовых составляющих цвета может при-
нимать только 256 целочисленных значений, каждое значение можно предста-
вить 8-разрядным двоичным числом (последовательностью из 8 нулей или еди-
ниц 256 = 28), или, другими словами, одним байтом. Напомним, что каждый
разряд в байте называется битом (двоичной единицей или нулем). Таким обра-
зом, в модели RGB информация о каждом цвете занимает 3 байта (по одному
байту на каждый базовый цвет) или 24 бита (8 ´ 3 = 24) памяти для хранения.
Поскольку все оттенки серого цвета образуются смешением трёх составляющих
одинаковой яркости, для представления любого из 256 оттенков серого требу-
ется лишь 1 байт.
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ЦВЕТОВЫЕ МОДЕЛИ CMY И CMYK

Модель CMY (читается «Цми») описывает отраженные цвета (краски).
Они образуются в результате вычитания части спектра падающего света и на-
зываются субтрактивными. При смешении двух цветов результат темнее обо-
их исходных, поскольку каждый из цветов поглощает часть спектра. Каналы
CMY — это результат вычитания основных RGB-компонентов из белого цвета,
то есть из полного (сплошного) спектра.

Тогда базовые цвета модели CMYK («Цмик») можно представить с по-
мощью формул вычитания базовых цветов модели RGB следующим образом:

Суаn (голубой) = RGB – R = GB = (0, 255, 255);
Yellow (жёлтый) = RGB – В = RG = (255, 255, 0);
Magenta (пурпурный) = RGB – G = RB = (255, 0, 255).
Базовые цвета модели CMY являются довольно яркими и не вполне под-

ходят для воспроизведения тёмных цветов. Так, при их смешении на практике
получается не чисто чёрный, а грязно-коричневый цвет.

Развитием модели CMY является CMYK. Она описывает реальный про-
цесс цветной печати на офсетной машине и принтере. Пурпурная, голубая и
жёлтая краски (полиграфическая триада) последовательно наносятся на бумагу
в различных пропорциях, и таким способом может быть репродуцирована зна-
чительная часть видимого спектра. В области чёрного и тёмных цветов нано-
сится не цветная, а чёрная краска. Это четвёртый базовый компонент, введен-
ный для описания реального процесса печати. Чёрный компонент сокращается
до буквы К (BlacK, или, по другой версии, Кеу). CMYK — четырёхканальная
цветовая модель.

Реальные краски содержат примеси и при смешении, как сказано выше,
дадут не чёрный, а тёмно-коричневый цвет. К тому же для печати очень тёмных
или чёрного цвета изображений необходимо большое количество каждой крас-
ки, что приведёт к переувлажнению бумаги и неоправданному расходу красок.

Смешение цветов в модели CMYK противоположно смешению состав-
ляющих в модели RGB (рис. 10б). Однако краски субтрактивной модели не яв-
ляются столь чистыми, как цвета аддитивной модели. Этим и объясняются сле-
дующие особенности:

- голубой и пурпурный при максимальной яркости дают глубокий синий
цвет с небольшим фиолетовым оттенком. Уменьшение яркости голубого дела-
ет цвет пурпурным, а уменьшение яркости пурпурного — средне-синим (жёл-
той краски нет совсем);

-пурпурный и жёлтый при максимальной яркости получают смесь яр-
ко-красного цвета. Уменьшение яркости пурпурной составляющей даёт оран-
жевый, а уменьшение яркости жёлтой — розовый цвет (голубая составляющая
отсутствует);

-жёлтый и голубой дают ярко-зелёный цвет с небольшим оттенком
синего. При уменьшении яркости жёлтого получается изумрудный цвет, а
уменьшение яркости голубого делает цвет салатовым (пурпурная составляющая
отсутствует).
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Цветовые диапазоны моделей RGB и CMYK не совпадают: RGB хорошо
воспроизводит цвета от синего до зелёного и несколько хуже — жёлтые и оран-
жевые оттенки, а в модели CMYK вообще отсутствуют очень многие оттенки.

Описанные цветовые модели являются аппаратно-зависимыми: при вы-
воде одного и того же изображения на различных устройствах (например, на
двух разных мониторах) получается неодинаковый результат. То есть цвет за-
висит как от значений базовых составляющих, так и от технических параметров
оборудования. Так, в процессе компьютерной обработки приходится преобра-
зовывать цвет из одной модели в другую. Поскольку эти модели имеют разный
цветовой охват, преобразование часто сопряжено с потерей части оттенков.

Поэтому одной из основных задач при работе с цветными изображениями
является достижение желаемого цвета. Для этого создана система цветокоррек-
ции Color Management System. CMS — это программная система, цель кото-
рой, во-первых, добиться одинаковых цветов на всех этапах полиграфического
процесса (от сканирования до печати), а, во-вторых, — обеспечить стабильное
воспроизведение цвета на всех выводных устройствах (например, на любом
мониторе). Она реализована в программном обеспечении Photoshop.

ЦВЕТОВАЯ МОДЕЛЬ LAB

Для правильного отображения цвета удобно определить стандартную мо-
дель, к которой бы приводились цвета на всех этапах процесса. Цветовая мо-
дель Lab (читается «Лаб») — это успешная попытка создания аппаратно-
независимой модели цвета, основанной на человеческом восприятии. В рам-
ках этой модели работают многие профессионалы компьютерной графики. Лю-
бой цвет в Lab определяется осветлённостью, или яркостью (Lightness)  и
двумя хроматическими компонентами: параметром а, который изменяется в
диапазоне от зелёного до красного, и параметром b, изменяющимся в диапазоне
от синего до жёлтого. Параметры а и b измеряются в процентах и могут нахо-
диться в диапазоне от 0 до 100 (рис. 11а).

а б
Рис. 11. Схематическое изображение цветовых кругов, соответствующих

аппаратно-независимым цветовым моделям: а — Lab; б — HSB
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Как и в RGB, смешение цветов из шкал а и b позволяет получить более
яркие цвета. Уменьшить яркость результирующего цвета можно за счет пара-
метра яркости L. Яркость в модели Lab полностью отделена от цвета. Это дела-
ет модель удобной для регулировки контраста, резкости и других тоновых ха-
рактеристик изображения. Модель Lab является трёхканальной. Её цветовой
охват чрезвычайно широк (включает охваты всех других цветовых моделей,
используемых в полиграфическом процессе) и соответствует видимому цвето-
вому охвату для стандартного наблюдателя.

Графический редактор Adobe Photoshop при переходе от режима RGB к
CMYK использует Lab в качестве промежуточного этапа.

ЦВЕТОВАЯ МОДЕЛЬ HSB

Многие художники пользуются цветовой моделью HSB (читается «Аш-
Эс-Бэ», или «Эйч-Эс-Би»), которая также является аппаратно-независимой.
Эта математическая модель очень удобна для подбора оттенков и цветов. Лю-
бой цвет в модели HSB определяется своим цветовым тоном (собственно цве-
том), насыщенностью (то есть процентом добавленной к цвету белой краски) и
яркостью (процентом добавленной чёрной краски). Эта трёхканальная модель
получила название по первым буквам английских слов Hue (Тон), Saturation
(Насыщенность) и Brightness (Яркость).

Насыщенность (Saturation) характеризует чистоту цвета. Нулевая на-
сыщенность (0 %) соответствует серому цвету, а максимальная (100 %) — наи-
более яркому варианту данного цвета. Можно считать, что изменение насы-
щенности связано с добавлением белой краски, то есть чем больше белой крас-
ки, тем меньше насыщенность.

Яркость (Brightness) понимается как степень освещенности. При нуле-
вой яркости (0 %) цвет становится чёрным. Максимальная яркость (100 %) при
максимальной насыщенности дают наиболее выразительный вариант данного
цвета. Можно также считать, что яркость изменяется путем добавления чёрной
краски, то есть чем больше чёрной краски, тем меньше яркость.

Графически модель HSB можно представить в виде кольца, вдоль которо-
го располагаются оттенки цветов (рис. 11б). На внешнем крае круга находятся
чистые спектральные цвета или цветовые тона (параметр Н измеряется в угло-
вых градусах от 0 до 360). Чем ближе к центру круга расположен цвет, тем
меньше его насыщенность, тем он более блёклый, пастельный (параметр S из-
меряется в процентах от 0 до 100). Яркость отображается на линейке, перпен-
дикулярной плоскости цветового круга (параметр В измеряется также в про-
центах от 0 до 100). Все цвета на внешнем круге имеют максимальную яркость.

Обратите внимание: яркость (Brightness) в смысле «освещённость» в
модели HSB не совпадает с яркостью (Lightness) в смысле «осветлённость» в
модели Lab.
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ТИПЫ РАСТРОВЫХ ИЗОБРАЖЕНИЙ

Photoshop поддерживает описание изображений в различных цветовых
моделях. В рамках программы существует также понятие типа изображения.
В Photoshop существуют следующие типы изображений:

- монохромные (Bitmap). В таком изображении есть только два цве-
та — чёрный и белый;

- полутоновые (Grayscale). Состоят из 256 оттенков серого цвета;
- полноцветные. Это цветные изображения, использующие цветовые

модели RGB (RGB Color), CMYK (CMYK Color) и Lab (Lab Color). Состоят
из нескольких цветовых каналов, каждый из которых представляет собой полу-
тоновое изображение, содержащее 256 оттенков;

- индексированные (Indexed Color). Это одноканальные цветные изо-
бражения, содержащие до 256 точно определённых цветов. Они применяются в
Web-дизайне, поскольку размеры индексированных изображений меньше, чем
аналогичных полноцветных;

- многоканальные (Multichannel). К этому типу относятся изображе-
ния, содержащие произвольное число цветовых каналов. Они применяются для
специальных целей, например, для печати дуплексов.

Для управления типом изображения используется команда: Menu >
Image > Mode (Изображение > Режим) > выбрать нужный тип изображения. В
этом же подменю задаётся глубина цвета изображения.

Глубина цвета (color depth) — важнейшая характеристика растровых
изображений, показывающая сколько бит памяти требуется для хранения одно-
го пиксела изображения. Чем больше глубина цвета, чем богаче цветовые от-
тенки изображения, тем больше объём файла.

В полутоновых изображениях (Grayscale) цвет пиксела (оттенки серого)
кодируется одним байтом (8 бит), поэтому максимальное число оттенков (гра-
даций) составляет 28 = 256. Объём памяти, занимаемой цветными изображе-
ниями, зависит от количества каналов. Каждый канал является полутоновым, то
есть кодируется одним байтом (28 = 256 градаций цвета). В модели RGB кана-
лов три, поэтому один пиксел кодируется 24 битами (8 бит ´ 3 канала). В моде-
ли CMYK четыре канала, поэтому глубина цвета — 32 битами (8 бит ´ 4 кана-
ла). Таким образом, память, занимаемая цветными изображениями, в три или
четыре раза больше, чем для полутоновых изображений. В программе
Photoshop каждому каналу, имеющемуся в изображении, выделяется своя
строчка на палитре Channels (Каналы). Выбрав какой-либо канал, с ним можно
работать отдельно, что очень удобно. На рисунке 3 изображено полноцветное
изображение в модели RGB и его каналы (Red, Green, Blue) в виде строк.
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ГЛАВА 4. ОБЩАЯ ТОНОВАЯ И ЦВЕТОВАЯ
КОРРЕКЦИИ ИЗОБРАЖЕНИЯ

Всю совокупность этих операций можно разделить на две группы: опера-
ции по общей коррекции всего изображения и операции по локальной коррек-
ции отдельных фрагментов изображения (выделенных его частей). Под опера-
цией общая коррекция понимается такая обработка всего изображения или вы-
деленной его части, при которой происходит изменение цветовых или тоновых
параметров по выбранному вами закону (алгоритму).

Все команды общей коррекции находятся в меню Image (Изображение):
Menu > Image (Изображение) > Adjustment (Настройка) > необходимая коман-
да коррекции (рис. 12). Команда Adjustment (Настройка) в версии Photos-
hop 6.0 называется немного иначе: Adjust (Настройка), что не изменяет её сути.

Рис. 12. Вид подменю Adjustment (Настройка) меню Image (Изображение)

ТОНОВАЯ КОРРЕКЦИЯ

Полученные с помощью цифрового фотоаппарата или сканирования фо-
тографии имеют недостатки — могут быть затемнёнными, с неразличимыми
деталями, слишком светлыми, недостаточно контрастными и т. д.

Отличие хорошей фотографии от плохой проявляется, прежде всего, в
правильном балансе света и тени. Тогда объекты съёмки выглядят рельефными
и хорошо воспринимаются глазом. В каждой фотографии есть сюжетно важная
часть, которая, как правило, наиболее богата деталями. В ней тоновый контраст
должен быть самым большим.
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ПОНЯТИЕ ТОНОВОЙ КОРРЕКЦИИ

Тоновая коррекция — процесс исправления погрешностей в освещении и
контрасте. Если вы видите дефект в тоне деталей изображения, то, скорее всего,
он присущ всему изображению целиком. Поэтому начинайте с общей коррек-
ции. Только после того, как вы добились оптимального соотношения тонов на
изображении в целом, переходите к корректировке его частей. Отдельные части
действительно необходимо корректировать лишь в случаях неправильного ос-
вещения места съёмки, недостатков проявки исходной фотографии или слайда.

Тон компьютерного изображения — это яркость пикселов, из которых
оно состоит. Та часть диапазона яркостей, которая использована в изображе-
нии, носит название тóнового диапазона. Чем шире тоновый диапазон, тем
«глубже» цвета и лучше вырисовываются детали. Именно эту задачу решает
коррекция светов и теней. В идеале в изображении должны быть использованы
все значения яркостей (тонá).

Если разбить весь тоновый диапазон на три неравные части, то самая тём-
ная часть будет называться тени, самая светлая — светá, а между ними распо-
ложится большой диапазон средних тонов.

ПРОВЕРКА НА ТОНОВЫЙ ДИАПАЗОН

Проверка на тоновый диапазон осуществляется в Photoshop 6: Menu >
Image (Изображение) > Histogram (Гистограмма) > откроется диалоговое окно
Histogram (Гистограмма).

Чтобы работать дальше, диалоговое окно следует закрыть, иначе другие
команды программы будут недоступны. Поэтому в Photoshop CS (версия 8)
диалоговое окно Histogram (Гистограмма) превращено в отдельную палитру с
тем же именем (палитра Histogram), что намного удобнее, так как палитра на-
ходится в окне программы постоянно. Корректируя изображение, можно его
контролировать по гистограмме. Структуры же и диалогового окна, и палитры
Histogram (Гистограмма) абсолютно одинаковы. В палитре Histogram можно
выбрать три режима просмотра: Compact View (Компактный вид), Expanded
Compact View (Улучшенный вид), All Channels View (Вид всех каналов)
(рис. 13). На рис. 13а изображён режим Compact View: видно меню палитры,
открываемое нажатием на круглую кнопку со стрелкой. Режим All Channels
View показывает ещё и гистограмму для трёх каналов RGB (рис. 13б).

Тоновый диапазон изображения представлен как график (гистограмма)
распределения количества пикселов по градациям яркости. Количество пиксе-
лов отложено по оси ординат (Оу), а по оси абсцисс (Ох) расположены уровни
яркости пикселов (levels) в диапазоне от 0 до 255. На гистограмме тени распо-
лагаются слева, а света — справа.

Чем больше пикселов расположено в данном интервале тонов, тем боль-
ше оттенков содержит этот интервал.
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Хорошее изображение содержит широкий диапазон тонов и большое ко-
личество оттенков. В таком изображении сюжетно важная часть имеет хороший
контраст и хорошо детализирована.

По характеру гистограммы изображения делятся на светлые, тёмные и
сбалансированные. На рис. 13 изображена гистограмма изображения с явным
преобладанием светлых тонов (светов).

Если в изображении отсутствуют самые тёмные и самые светлые тона,
оно выглядит тусклым, словно подёрнутым пылью — его пикселы слишком
мало отличаются по яркости.

                            а                                                                              б
Рис. 13. Вид палитры Histogram (Гистограмма):

а — режим Compact View (Компактный вид); б — режим Expanded Compact View (Улучшенный
вид)

Изображение может иметь дефекты: суженный тоновый интервал или не-
достаточный контраст, излишне тёмное или слишком светлое, погрешность в
контрасте или яркости определённого интервала тонов. Для исправления этих
недостатков и применяется тоновая коррекция.

Чтобы фотография ожила, нужно растянуть её тоновый диапазон.
Это повысит контраст изображения: углубит тени и осветлит света. Коррекция
такого изображения сведётся к отсечению самых тёмных и светлых тонов, в ко-
торых практически нет пикселов. Существующие тона расположатся более рав-
номерно по всему тоновому диапазону, в результате контраст изображения вы-
растет, в нём появятся привлекательные тени и блики.

Но, надо учитывать, что при сильном растягивании интервала изображе-
ние потеряет плавность перехода оттенков и станет похожим на плакат.

ПРОСТЕЙШИЕ МЕТОДЫ ТОНОВОЙ КОРРЕКЦИИ

Команда Auto Levels (Автоматическая тоновая коррекция) предназначена
для тоновой коррекции изображения в автоматическом режиме: Menu >
Image  >  Adjustment  >  Auto  Levels (Изображение > Настройка > Автоматиче-
ская тоновая коррекция). Программа в изображении выбирает самый тёмный и
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самый светлый пиксели, которые делают абсолютно чёрным и абсолютно бе-
лым его участки. При этом уровни яркости остальных пикселей изображения
равномерно распределяются от чёрного до белого.

С помощью команды Egualize (Выровнять яркость) можно осуществить
статистическое выравнивание яркостных характеристик изображения, то есть
уменьшить перепад яркостей. Эта команда выполняется автоматически:
Menu  >  Image  >  Adjustment  >  Egualize (Изображение > Настройка > Выров-
нять яркость).

Команда Brightness/Contrast... (Яркость/Контраст...) реализует самый
простой и эффективный способ регулировки основных тоновых параметров
изображения. Она также предназначена для настройки яркости, контрастности:
Menu > Image > Adjustments > Brightness/Contrast (Изображение > Установ-
ки > Яркость/Контрастность). При этом открывается диалоговое окно
Brightness/Contrast... (Яркость/Контраст) (рис. 14), в котором есть две шкалы с
ползунками, позволяющие отдельно регулировать яркость (шкала Brightness) и
контрастность изображения (шкала Contrast).

Рис. 14. Вид диалогового окна Brightness/Contrast... (Яркость/Контраст...)

Здесь же вы можете предварительно просмотреть полученный результат,
если поставлен флажок Preview (Предварительный результат).

Кроме управления яркостью и контрастом можно задавать уровни белого
и чёрного цветов. По умолчанию уровень яркости чёрного цвета равен 0, а бе-
лого — 255. Если, например, понизить уровень белого, пикселы, имеющие
большую яркость, приобретут максимальную яркость.

Аналогично, если повысить уровень чёрного, все более тёмные пикселы
станут чёрными.

В Photoshop имеются ещё два средства, которые обычно используют про-
фессионалы: Levels (Уровни) и Curves (Кривые) — гибкие инструменты, по-
зволяющие довольно точно скорректировать изображение, вплоть до пиксела.

Обратите внимание, что в графических программах инструментами в
широком смысле называют часто не только инструменты на панели инстру-
ментов, но и другие средства работы с изображением: команды, диалоговые ок-
на, фильтры и т. д. Инструменты на панели инструментов — это инструменты
в узком смысле.

Некоторые пользователи предпочитают инструмент Levels (Уровни), дру-
гие используют исключительно Curves (Кривые). Эти диалоговые окна вызы-
ваются командой Menu > Image > Adjustments (Изображение > Установка).
Рассмотрим их подробнее.
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ДИАЛОГОВОЕ ОКНО LEVELS (УРОВНИ)

Команда Levels... (Уровни...) используется для выполнения тоновой кор-
рекции изображения в ручном режиме.

Команда Menu  >  Image  >  Adjustments  > Levels (Изображение > Уста-
новка > Уровни) открывает диалоговое окно Levels (Уровни) (рис. 15).

Рис. 15. Вид диалогового окна Levels... (Уровни...)

В этом окне содержится гистограмма, отображающая распределение пик-
селов изображения по уровням яркости: по горизонтали отложены уровни яр-
кости, а по вертикали — доля пикселов с соответствующей яркостью.

Прежде всего, в раскрывающемся списке Channel (Канал) нужно выбрать
канал, который вы хотите редактировать. Можно корректировать и изображе-
ние целиком, не разделённое на каналы, а также выделенную область.

Регулировка тонового диапазона производится с помощью двух шкал:
входной (Input Levels) и выходной (Output Levels). Идея состоит в том, чтобы
входные характеристики изображения преобразовать в новые (выходные) зна-
чения. Первая шкала (прямо под гистограммой) позволяет увеличивать контра-
стность изображения. Вторая же, находящаяся под полями ввода Output Levels
(Выходные уровни), уменьшает его.

Входные уровни (Input Levels) бывают трёх типов (видно три поля вво-
да): уровень тёмных пикселов (левое поле), гамма — уровень серого (полуто-
новых пикселов) — среднее поле и уровень светлых пикселов (правое поле).
Эти параметры устанавливают диапазон яркости пикселов исходного изобра-
жения, которые вы хотите подвергнуть преобразованию. Задавая значения
входных параметров, вы указываете, какие пикселы требуется преобразовать, а
какие — оставить без изменений.

Например, введя в левое поле 128, а в правое — 200, вы указываете гра-
фическому редактору, что собираетесь изменить яркость канала, выбранного в
списке Channel (Канал), или пикселов всего изображения, яркость которых за-
дается в диапазоне от 128 до 200.
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Вместо ввода числовых значений входных параметров можно воспользо-
ваться ползунками, расположенными ниже гистограммы (входная шкала). Ле-
вый ползунок чёрного цвета соответствует значениям левого поля ввода (уро-
вень тёмного), правый белого цвета — правого (уровень светлого). Средний
ползунок серого цвета задаёт значение параметра Гамма (уровень серого, то
есть среднего тона).

Говорят: «Ползунки указывают опорные точки изображения».
Итак, входные параметры являются аргументами преобразования ярко-

сти. Пикселы, не входящие в диапазон преобразования, остаются без измене-
ний. Поэтому пикселы с яркостью менее 128 и более 200 не участвуют в преоб-
разовании, осуществляемом инструментом Levels (Уровни). В этой связи ука-
занные входные значения называют иногда значениями отсечки. На рисун-
ке 15 видно, что изображение содержит весь диапазон тонов от 0 до 255. К это-
му и нужно стремиться при корректировке.

Полей ввода выходных уровней (Output Levels) всего два. Они задают
границы диапазона яркости, в котором будет находиться яркость преобразо-
ванных пикселов исходного изображения, имеющих указанные значения вход-
ных параметров. Эти границы следует понимать как пороговые значения.

Все пикселы исходного изображения, которые соответствуют диапазону
входных параметров, пропорционально получают новые значения яркости в
шкале, заданной выходными параметрами. Вместо ввода числовых значений с
клавиатуры можно воспользоваться ползунками на второй шкале, расположен-
ной ниже полей ввода Output Levels.

Кроме описанных выше полей ввода чисел и шкал с ползунками, имеется
группа из трёх кнопок с изображением пипеток . Пипетки позволяют
прямо на исходном изображении указать опорные точки. Результат преобразо-
вания зависит от вида пипетки.

Левая пипетка (выбор чёрной опорной точки) позволяет указать прямо на
изображении, какой цвет будет в результирующем изображении чёрным (обра-
зец минимальной яркости).

Средняя пипетка (выбор полутоновой опорной точки) указывает, какой
цвет будет в результирующем изображении серым (образец средней яркости).

Правая пипетка (выбор белой опорной точки) позволяет выбрать, какой
цвет будет в результирующем изображении белым (образец максимальной яр-
кости). Щелчок на кнопке ОК приводит к применению установок параметров.

Кроме этого, в диалоговом окне ещё есть кнопки. Их необходимо рас-
смотреть подробнее, так как они повторяются во многих диалоговых окнах
корректировки изображения:

- Save (Сохранить) дает возможность сохранить текущие установки па-
раметров в специальном файле с расширением .alv, чтобы потом их можно бы-
ло использовать;

- Load (Загрузить) позволяет загрузить в диалоговое окно параметры
коррекции изображения из файла с расширением .alv;
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- Auto (Авто) приводит к автоматической коррекции изображения по
некоторому внутреннему алгоритму так, что самые тёмные пикселы становятся
чёрными, а самые светлые — белыми. При этом яркость остальных пикселов
равномерно распределяется по всему диапазону яркости. При нажатии клавиши
Alt кнопка Auto (Авто) изменяет свой вид на Options (Опции), а 1щЛ на ней
при этом открывает диалоговое окно для задания так называемых диапазонов

отсечения пикселов , представляющих собой доли самых
тёмных и самых светлых пикселов (в процентах), которые будут игнорировать-
ся при преобразовании;

- установленный флажок Preview (Предварительный просмотр) позво-
ляет просматривать результаты изменения уровней в окне изображения при от-
крытом окне Levels (Уровни).

При преобразованиях уровней яркости следует помнить, что на результи-
рующем изображении могут появиться резкие перепады яркости (блики, затем-
нения), что обусловлено линейчатостью гистограммы.

Инструмент Levels (Уровни) является всего лишь средством коррекции
изображения, в котором перечисленные параметры задаются взаимосвязанно.

Рекомендуем самостоятельно поэкспериментировать с этим инструмен-
том на специально подобранном тестовом изображении, лучше всего — на гра-
диенте цветов.

ДИАЛОГОВОЕ ОКНО CURVES (КРИВЫЕ)

Команда Menu > Image > Adjustment > Curves (Изображение > Уста-
новка > Кривые) открывает диалоговое окно Curves (Кривые) (рис. 16а).

а б
Рис. 16. Вид диалогового окна Curves (Кривые):

а — при открытии окна; б — при изменении кривой яркости
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В раскрывающемся списке Channel (Канал) в верхней части окна выби-
раем цветовой канал, в котором будет проводиться тоновая коррекция. Лучше
корректировать по тону и яркости всё изображение целиком (как на рисун-
ке 10а, где указан тип изображения RGB).

При корректировке отдельных каналов цветного изображения изменения
вносятся сразу во все каналы, что приводит к разбалансировке цветов. Поэтому,
тоновую коррекцию отдельных каналов цвета удобно производить в модели
Lab, чтобы не потерять цветовые оттенки. Как перевести изображение в цвето-
вую модель Lab смотрите выше в подглаве «Типы растровых изображений».

Выставив в раскрывающемся списке Channel (Канал) канал яркости L
(Lightness), можно отдельно изменять кривую яркости. Цветовые каналы а и b
при этом не пострадают, диапазон цветов начального и отредактированного
изображений будет одинаков.

В центре диалогового окна Curves (Кривые) расположен график соответ-
ствия вводных уровней яркости (по горизонтали) и выводных (по вертикали),
называемый кривой яркости. В исходном положении этот график представляет
собой прямую линию с наклоном в 45°. Это означает, что выводные уровни
равны вводным (соответствие 1:1). Поле графика по умолчанию разбито на 16
квадратов (при желании его можно разделить и на большее количество — 100).
Чтобы переключиться из одного режима отображения сетки в другой, нажмите
клавишу Alt и щёлкните на поле.

Внизу графика отображается шкала яркости. Если тёмный конец шкалы
находится слева, то цвета RGB-изображений измеряются значениями яркости.
Если щёлкнуть на кнопочке  или даже в любом месте этой шкалы, шкала
яркости инвертируется: тёмный конец окажется справа, а светлый — слева. В
этом случае цвета будут измеряться в терминах типографской печати. Такая ус-
тановка предусмотрена по умолчанию для чёрно-белых и CMYK-изображений.
В Web-графике следует использовать RGB-установку, при которой тёмный ко-
нец шкалы находится слева, а светлый — справа.

Кривую яркости на графике можно изменять различными способами
(рис. 16б).

Во-первых, её можно нарисовать произвольно (если вы предварительно

щёлкнули на кнопке с изображением карандаша  в этом диалоговом окне).

Если после этого вы выберите кнопку Smooth (Плавный ), то нарисованная
вами кривая будет сглажена.

Во-вторых, можно щелчками указать точки на кривой, а затем перета-
щить их мышью в нужное место (если вы предварительно щёлкнули на кнопке

с изображением кривой ). Для удаления точки на кривой, следует сделать на
ней 1щЛ ещё раз.

В-третьих, можно щелчками указать точки, которые не должны изменять
своего положения на кривой, а затем перетащить мышью те участки кривой,
которые расположены между этими точками. Кривая пройдет через все эти точ-
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ки. В результате изменится соответствие между входными и выходными значе-
ниями яркости.

Редактирование тоновых кривых в диалоговом окне Curves (Кривые) по-
зволяет проводить любую коррекцию путём изменения формы кривой. Смеще-
ние кривой меняет яркость, регулировка наклона корректирует контраст.

Например, чтобы сделать изображение более контрастным, следует по-
строить кривую (рис. 17а). При такой кривой сужается диапазон средних по яр-
кости пикселов: светлые пикселы становятся ещё светлее, а тёмные — ещё тем-
нее. Для повышения яркости светлых тонов кривая будет другая (рис. 17б).

Рекомендуем самостоятельно поэкспериментировать с данным инстру-
ментом на каком-нибудь тестовом изображении.

а б
Рис. 17. Вид кривой яркости:

а — для увеличения контрастности изображения; б — для повышения яркости светлых тонов

В полях Input (Ввод) и Output (Вывод) отображаются значения яркости,
соответствующие выделенной точке кривой. Чтобы выделить точку, щёлкните
на ней. Можно ввести данные в эти поля с клавиатуры, и тогда кривая также
изменит вид. Это четвёртый способ изменения кривой яркости.

Как и в окне Levels (Уровни), кнопка Save (Сохранение) позволяет сохра-
нить установки кривых в специальном файле с расширением .acv. Обратите
внимание, что сохранение установок кривых производится в другом файле, от-
личном от файла сохранения установок уровней.

Кнопка Load (Загрузка) обеспечивает загрузку в диалоговое окно Curves
(Кривые) параметров из файла.

Установленный флажок Preview (Предварительный просмотр) позволяет
просматривать результаты изменения кривой в окне изображения при открытом
окне Curves (Кривые).

Итоги обзора возможностей данного инструмента можно сформулировать
примерно так же, как и в случае инструмента Levels (Уровни).

Часто спорят, какой из этих инструментов лучше. Как правило, эффек-
тивнее тот, которым вы лучше владеете. Однако отметим, что Levels (Уровни)
и Curves (Кривые) превосходят по своим возможностям простые инструменты
коррекции изображения, рассмотренные выше (окна со шкалами коррекции яр-
кости и контрастности и автоматическую коррекцию).
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Таким образом, порядок тоновой коррекции изображения можно раз-
бить на следующие этапы:

1. Выполните общую коррекцию тона: установите света и тени. Удобно
пользоваться окном Levels (Уровни). При коррекции следите, чтобы изображе-
ние было как можно более детализированным и не потеряло оттенки. Это удоб-
но отслеживать по гистограмме. Если на первом этапе коррекции изображение
потеряет значительную часть градаций тона, то возможности его дальнейшего
исправления будут невелики. Для полутонового изображения часто полезно ав-
томатически определять чёрную и белую точки.

2. Определите средние тона. Если изображение сложное, воспользуйтесь
тоновыми кривыми Curves (Кривые) для того, чтобы установка средних тонов
была точной. Помещайте основной эффект осветления или затемнения в об-
ласть сюжетно важных тонов.

3. Выполните коррекцию тоновых интервалов. При коррекции изменения
вносятся во все каналы, что может привести к их разбалансировке. Поэтому,
если изображение цветное, тоновую коррекцию в каналах проводят в модели
Lab, чтобы не потерять оттенки в цветах.

ЦВЕТОВАЯ КОРРЕКЦИЯ

БАЛАНСИРОВКА ЦВЕТОВ

Изображения могут иметь широкий спектр дефектов передачи цвета. Эти
дефекты условно делятся на три большие группы: цветовые сдвиги (нарушение
баланса цветов в изображении), нежелательные изменения отдельных цветов,
погрешности в цветовом решении отдельных частей изображения. Первый тип
цветовых дефектов встречается чаще всего.

Поэтому сначала изучается изображение на предмет цветовых сдвигов,
то есть несоответствий цветов изображения натуральным. Прежде всего, обра-
тите внимание на передачу оттенков кожи и знакомых цветов, а также на свет-
лые и нейтральные серые тона. Для более точной диагностики используйте ин-

струмент Eyedropper (Пипетка ). Выбрав этот инструмент, следует щёлк-
нуть в том месте изображения, цвет которого вы хотите узнать. Таким образом
измеряется цвет данной точки. На палитре Info (Инфо) появится информация
об этой точке в цветовой модели, с которой вы в данный момент работаете. Ес-
ли измеренное значение для данного цвета сильно отличается от стандартного,
то в данном тоновом диапазоне есть сдвиг. Знание того, какие же числовые
значения являются стандартными, приходит, в основном, с опытом. Поэтому не

стесняйтесь часто использовать инструмент Eyedropper (Пипетка ).
Следует помнить, что коррекция цвета проводится для фотореалистичных

изображений целиком, то есть только в случае обработки всего изображения
можно добиться правдоподобных цветов. Для цветного изображения важен ба-
ланс цветов. Для ликвидации общих цветовых сдвигов используется диалоговое
окно Levels (Уровни), описанное выше.
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Балансировка цветов — это избавление от цветовых сдвигов, то есть по-
лучение изображения с реалистичными цветами.

Для балансировки цвета по тоновым интервалам нужно использовать то-
новые кривые (Curves).

Существует несколько менее точный, но более простой метод цветовой
коррекции — работа с диалоговым окном Color Balance (Цветовой баланс):
Menu  >  Image  >  Adjustment  > Color Balance (Изображение > Установка >
Цветовой баланс) (рис. 18).

Рис. 18. Вид диалогового окна Color Balance... (Цветовой баланс...)

В диалоговом окне Color Balance... (Цветовой баланс...) вы можете диф-
ференцировать цветовую регулировку изображения для теней (переключатель
Shadows), средних тонов (Midtones) и светов (Highligths). Сначала следует вы-
брать соответствующий переключатель, а затем, передвигая ползунки, сбалан-
сировать цвет между дополняющими друг друга цветами. Важна активизация
флажка Preserve Luminosity (Сохранить яркость тонов), которая позволит
обеспечить неизменность тоновых характеристик изображения при выполнении
его цветовой коррекции.

КОРРЕКЦИЯ ЦВЕТОВЫХ ТОНОВ

Если балансировка не удаётся или изображение исправлено не полно-
стью, значит, есть погрешность цвета. Необходимо исправить содержание и
тон отдельных цветовых интервалов изображения, то есть откорректировать
цвета. Для этого используют диалоговые окна Hue/Saturation (Цветовой
тон/Насыщенность) и Selective Color (Избранные цвета).

Сначала выполняется цветовая коррекция изображения заданного цве-
тового диапазона в диалоговом окне Hue/Saturation (Цветовой тон/Насыщен-
ность): Menu > Image > Adjustment > Hue/Saturation (Изображение > Уста-
новка > Цветовой тон/Насыщенность) (рис. 19).
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В данном диалоговом окне выбирается диапазон регулировок в раскры-
вающемся списке Edit (Правка) — для одного из шести базовых цветов и их от-
тенков, используемых в цветовом круге: Reds (Красные тона), Greens (Зелёные
тона), Blues (Синие тона), Cyans (Голубые тона), Magentas (Пурпурные тона),
Yellows (Жёлтые тона). Цвета воспринимаются со всеми их оттенками (тона-
ми), поэтому указываются во множественном числе.

Рис. 19. Вид диалогового окна Hue/Saturation (Цветовой тон/Насыщенность)

Этот диапазон можно также задать прямо на изображении, используя
кнопки-пипетки. Для выбранного цветового диапазона можно регулировать на
отдельных шкалах три цветовых параметра: цветовой тон (Hue), насыщенность
(Saturation) и яркость (Lightness). Установленный флажок Preview (Предвари-
тельный просмотр) позволяет просматривать результаты цветовых изменений
прямо в окне изображения при открытом диалоговом окне Hue/Saturation
(Цветовой тон/Насыщенность).

В нижней части этого окна находятся две радужные полосы, на каждой из
которых представлен цветовой круг, рассечённый на голубом цвете. На верхней
полосе показано состояние цветов до коррекции, на нижней — после неё.

Если результат коррекции неудовлетворителен, определите цветовые ин-
тервалы и отрегулируйте их в отдельности. В случае хорошо различимых цве-
тов изображения можно воспользоваться коррекцией в окне Selective Color
(Избранные цвета).

Команда Selective Color... (Выборочная коррекция цвета...): Menu >
Image > Adjustment > Selective Color... (Изображение > Установка > Выбороч-
ная коррекция цвета...), — также используется для цветовой коррекции изобра-
жения. Однако в данном случае коррекция производится для базовых цветов
цветовых моделей RGB и CMYK, выбираемых из списка Colors в диалоговом
окне команды (рис. 20).

Работа с диалоговыми окнами Selective Color... (Выборочная коррекция
цвета…) и Hue/Saturation (Цветовой тон/Насыщенность) очень схожа, но су-
ществуют и некоторые различия.

Окно Hue/Saturation (Цветовой тон/Насыщенность) позволяет управлять
цветами исключительно гибко, но этот метод более трудоёмок.
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Окно Selective Color... (Выборочная коррекция цвета…) гораздо проще,
но не позволяет выбрать произвольный интервал для коррекции. Преимущест-
вами являются простое управление яркостями цветов в интервалах (передвиже-
ние ползунка по шкале Black (Чёрный) в модели CMYK) и корректировка об-
щих цветовых сдвигов для остальных цветов. Обратите внимание, что в шка-
лах указаны не балансы, а сами цвета в процентах.

Рис. 20. Вид диалогового окна Selective Color... (Выборочная коррекция цвета…)

Команда Replace Color... (Заменить цвет...): Menu  >  Image  >
Adjustment > Replace Color... (Изображение > Установка > Заменить цвета...)
— позволяет выделить любую область изображения с заданными цветовыми
оттенками пикселей и раскрасить в цвет, выбранный вами (рис. 21).

Рис. 21. Вид диалогового окна Replace Color... (Заменить цвет...)
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В центре диалогового окна Replace Color... (Заменить цвет...) находится
окно просмотра, в котором можно отобразить выделенную область изображе-
ния, выбрав положение переключателя Selection (Выделение), либо всё изо-
бражение, щёлкнув на Image (Изображение).

Диапазон цветовых оттенков, включаемых в область коррекции, регули-
руется ползунком на шкале Fuzziness (Рассеяние) в верхней части диалогового
окна. В правом нижнем углу имеется образец цвета выделенной области.

С помощью шкал в группе Replacement (Преобразование), находящихся
в нижней части окна, производится регулировка цвета как этого образца, так и
всей выделенной области (изображения). Если установлен флажок Preview, то в
режиме предварительного просмотра можно увидеть в рабочем окне документа
результат воздействия этой команды на изображение.

Команда Channel Mixer.... (Смешение каналов...) позволяет выполнять
цветовую коррекцию изображений путем обработки их цветовых каналов:
Menu > Image > Adjustment > Channel Mixer.... (Изображение > Установка >
Смешение каналов...) (рис. 22).

Рис. 22. Вид диалогового окна Channel Mixer... (Смешение каналов...)

Суть такой обработки состоит в том, что одноцветное изображение каж-
дого цветового канала, выбираемого в раскрывающемся списке Output
Channel (Канал вывода), можно откорректировать путем смешения в нём в за-
данной пропорции всех цветовых каналов исходного цветного изображения,
представленных ниже в группе Source Channels (Каналы- источники) в виде
шкал с ползунками. Количество этих каналов и их типы определяются цветовой
моделью изображения. Контраст настраивается с помощью шкалы Contrast. На
рисунке 22 показано диалоговое окно Channel Mixer... (Смешение каналов...),
позволяющее выполнять цветовые настройки RGB-изображений. Каналом вы-
вода (Output Channel) здесь является красный цвет (Red).

Полагаем, что самостоятельное изучение этого диалогового окна не за-
труднит читателей.
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КОМПЛЕКСНАЯ КОРРЕКЦИЯ ИЗОБРАЖЕНИЯ
В ДИАЛОГОВОМ ОКНЕ VARIANTS (ВАРИАНТЫ)

Команда коррекции изображения Variants... (Варианты...): Menu >
Image > Adjustment > Variants... (Изображение > Установка > Варианты...) в
отличие от предыдущих, позволяет выполнить комплексную коррекцию изо-
бражения, то есть цветовую и тоновую одновременно.

Все необходимые регулировки цветовых и тоновых параметров изобра-
жения проводятся в диалоговом окне команды (рис. 23).

Рис. 23. Вид диалогового окна Variations (Варианты).
Отдельно укрупнена область расположения переключателей и кнопок

В этом окне полезно также определить общее направление коррекции, ес-
ли вы в нём не уверены.

Для балансировки цветов также удобна пошаговая коррекция в диалого-
вом окне Variations (Варианты), проводимая методом последовательных при-
ближений.

С помощью переключателя, находящегося вверху этого окна, вы можете
выбрать один из четырех диапазонов, в которых будут выполняться настройки:
Shadows (В тенях), Midtones (В полутонах), Highlights (В светах) и Saturation
(Насыщенность). А с помощью шкалы с ползунком, расположенной чуть ниже,
можно задать шаг коррекции перемещением движка влево, сделав регулировку
более точной (Fine), или вправо — менее точной (Coarse).
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Работа с диалоговым окном Variants (Варианты) не вызывает затрудне-
ний. При выполнении цветовой коррекции используют образцы изображений,
находящиеся в левой части окна и очерченные рамкой. В центре расположено
корректируемое изображение (Current Pick), а вокруг него шесть образцов с
заданными цветовыми оттенками (More желаемый цвет (Больше желаемого
цвета)). Последовательно щёлкая на тех или иных образцах, вы прибавляете к
корректируемому изображению соответствующие оттенки.

Аналогичным образом выполняется и тоновая коррекция. Все операции
здесь производятся с тремя образцами, расположенными столбиком в правой
части диалогового окна. Щелчок на верхнем образце Lighter (Светлее) делает
корректируемое изображение, находящееся в центре столбика (Current Pick),
более светлым, а на нижнем Darker (Темнее) — более тёмным. Установив фла-
жок Show Clipping (Показать обрезаемое), можно просмотреть те участки изо-
бражения, в которых при коррекции превышен допустимый уровень различий в
цветах или тонах.

Можно отменить выполненные корректировки, не выходя из диалогового
окна Variants (Варианты), щёлкнув на образце Original (Оригинал), располо-
женном в верхнем левом углу экрана.

РЕЗКОСТЬ

При оценке качества изображения часто используется такая характери-
стика, как резкость или чёткость (sharpen). Противоположной ей по смыслу
является размытость (blur). Резкость является функцией контрастности
(повышение резкости достигается за счёт увеличения контрастности соседних
пикселов изображения). Если чёрная линия размыта, то понять, что такое чёт-
кая линия, просто. Размытая чёрная линия на белом фоне имеет по краям серые
пикселы, яркость которых существенно отличается от пикселов основного цве-
та линии. Чтобы повысить резкость линии, достаточно увеличить её контраст-
ность. В результате светло-серые пикселы станут более светлыми или даже бе-
лыми, а тёмно-серые ещё больше потемнеют или даже превратятся в чёрные.

В Photoshop имеются средства повышения резкости изображения, кото-
рые находятся: Menu > Filters > Sharpen (Фильтры > Резкость). Среди фильт-
ров программы, изменяющих резкость изображения, особо отметим фильтр под
несколько странным названием Unsharp Mask (Нечёткая маска) (рис. 24):
Menu > Filters > Sharpen > Unsharp Mask (Фильтры > Резкость > Нечёткая
маска). Именно он во многих случаях наиболее эффективен. В окне фильтра
Unsharp Mask (Нечёткая маска) можно настроить следующие параметры:

1. Amount (Количество) — степень увеличения контраста пикселов.
2. Radius (Радиус) определяет ширину контура, подвергаемого воздейст-

вию инструмента.
3. Threshold (Порог) задаёт диапазон яркости соседних пикселов, при

котором будет увеличиваться их резкость.
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В основе алгоритма работы фильтра Unsharp Mask (Нечёткая маска) ле-
жит сравнение корректируемого изображения со слегка размытой его копией.
Эта копия и называется нечёткой маской.

Рис. 24. Вид подменю Sharpen (Резкость) меню Filter (Фильтр)
и диалоговое окно Unsharp Mask (Нечёткая маска)

Цель такого сравнения — выявить области, содержащие контуры, для по-
вышения контрастности последних. Сравнение происходит в небольших облас-
тях, размер которых можно устанавливать. Степень повышения контрастности
также регулируется. Наконец, можно задать значение уровня отличия пикселов
по яркости, чтобы определить контур. Это делается изменением параметра
Threshold (Порог).

Фильтр Sharpen (Резкость) немного повышает резкость изображения за
счёт увеличения различий между цветовыми оттенками соседних пикселов.

Фильтр Sharpen Edges (Резкие границы) незначительно повышает рез-
кость изображения за счёт увеличения различий между пикселами, существен-
но отличающихся по цвету от соседних. В результате получается эффект уве-
личения резкости на границах (краях) изображения.

Фильтр Sharpen More (Больше резкости) работает так же, как и Sharpen
(Резкость), но действие в три раза сильнее.

Следует отметить, что иногда нужно наоборот размыть изображение:
Menu > Filters > Blur (Фильтры > Размытость).
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ГЛАВА 5. ЛОКАЛЬНАЯ КОРРЕКЦИЯ ИЗОБРАЖЕНИЯ

ИСПОЛЬЗОВАНИЕ ИНСТРУМЕНТОВ РЕДАКТИРОВАНИЯ

Локальная коррекция — это коррекция фрагментов данного изображе-
ния. Выполняется с использованием инструментов редактирования, которые
находятся на панели инструментов (рис. 1). Рассмотрим их функции.

Инструменты тоновой коррекции и насыщенности Dodge (Осветление

), Burn (Затемнение ) и Sponge (Губка ) исправляют местные де-
фекты освещения или случайные изменения насыщенности цветов. Sponge

(Губка ) регулирует увеличение или уменьшение насыщенности цвета.
Расфокусировка изображения позволяет избавиться от шумов, удалить

мелкие дефекты. Снижение резкости производится инструментами группы Blur

(Размытие ).
Для местной коррекции резкости применяют инструменты Sharpen (Рез-

кость ) и Blur (Размытие ), действующие лишь на определённые участ-
ки изображения.

Инструмент Smudge (Палец ) размазывает цветовые границы, пред-
назначен для ликвидации дефектов типа прыщиков или трещин. Иногда дефек-

ты можно удалить инструментом Eraser (Ластик ), который заменяет пик-
селы цветом фона или любым, выбранным вами.

Возможна отмена корректирующего воздействия с помощью инструмента

History Brush (Восстанавливающая кисть ).
Если в изображении есть лишние или недостающие области, сильные за-

ломы, трещины, царапины, то в ряде случаев от них удаётся избавиться инст-

рументом Clone Stump (Штамп ).
Все перечисленные операции по локальной коррекции затрагивают лишь

те пиксели изображения, на которые воздействует соответствующий инстру-
мент. Сфера его воздействия (величина круглой площадки (кисти), внутри ко-
торой выполняется коррекция пикселей изображения) выбирается в палитре

Brush (Кисть) на панели параметров инструмента . На этой же пане-
ли устанавливается и степень воздействия. Рассмотрим это подробнее.

РАБОТА С КИСТЯМИ

ПОНЯТИЕ КИСТИ (BRUSH)

В программе Photoshop большинство инструментов действуют на основе
кисти, используя её в качестве трафарета, аппликатора или кончика инстру-
мента определённого размера, ограничивающего область воздействия инстру-
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мента. Кисть (Brush) является параметром инструментов рисования, корректи-
ровки, восстановления и других.

Щелчок левой клавишей мыши в нужном месте изображения активирует
кончик кисти выбранного инструмента (появляется пятно размером с выбран-
ный кончик кисти). Удержание нажатой левой клавиши мыши при переме-
щении курсора приводит к повторному применению выбранного инструмента:
передвигая курсор, рисуется линия установленного размера и формы.

Доступ к выбору и изменению кисти становится возможным при выборе
какого-нибудь инструмента. При этом появляется панель параметров этого ин-
струмента, которая включает раскрывающуюся палитру Brush (Кисть)

.

Меню действий кисти открывается 1щЛ на кнопке  (рис. 25).

Рис. 25. Вид открытой палитры Brush (Кисть) на панели параметров инструмента
в режиме Stroke Thumbnail (Этикетка с образцом линии) и открытое меню палитры

Обычно палитра Brush (Кисть) содержит набор доступных вариантов
кистей, каждая из которых представлена в виде небольших картинок (этике-
ток) кончика кисти (аппликатора). Этот режим называется Small Thumbnail

Этикетка
Thumbnail

Кнопка открытия
меню палитры

Список кистей
в этом наборе

Палитра
Brush

Список дополни-
тельных наборов

Действия
над

кистями

Вид кистей
в палитре
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(Маленькая этикетка). Однако вид отображаемых аппликаторов может быть
изменен на Large Thumbnail (Большая этикетка), Stroke Thumbnail (Этикетка
с образцом линии, нарисованной данной кистью), Text Only (Только название
кисти) или два вида списка названий с картинками-этикетками (Small List и
Large List). У существующего аппликатора может быть изменено имя с помо-
щью команды Rename Brush (Переименовать кисть), а также он может быть
удален командой Delete Brush.

Текущий набор доступных вариантов аппликаторов может быть:
- сохранён в файл Save Brushes (Сохранить кисти);
- добавлен дополнительным набором аппликаторов Load Brushes (За-

грузить кисти);
- заменён другим набором аппликаторов Replace Brushes (Заменить

кисти);
- восстановлен в виде набора аппликаторов, имеющихся в программе по

умолчанию Reset Brushes (Восстановить кисти).

ИЗМЕНЕНИЕ КИСТЕЙ

Во время работы над изображением возникает необходимость в измене-
нии параметров кончика кисти. Для этого следует открыть палитру Brush
(Кисть) в строке параметров выбранного вами инструмента (рис. 25). Но чаще
просто щёлкают правой клавишей мыши (1щП) на изображении, всплывает та
же панель Brush (Кисть), где и нужно изменять параметры кисти.

Настроим на шкалах с ползунками Master Diameter (Диаметр) и
Hardness (Жёсткость) диаметр и жёсткость.

Шкала Master Diameter (Диаметр) определяет размер кончика кисти в
пикселах. Для кисти правильной (круглой) формы диаметр может быть в диапа-
зоне от 1 до 1000 пикселов.

Шкала Hardness (Жёсткость) изменяется в диапазоне 0–100 %, что по-
зволяет создавать кисти с прозрачными краями.

Характеристики кисти, вынесенные на панель параметров инструмента,
включают, прежде всего, поле ввода Opacity (Непрозрачность ). В
этом поле указывается степень непрозрачности линии в процентах, выписывае-
мой кистью.

Если сделать 1щЛ на кнопке правее этого текстового поля, откроется

шкала , с помощью которой изменение непрозрачности можно
осуществить интерактивно, двигая ползунок вдоль этой шкалы.

Остальные параметры кисти различны для разных инструментов.
Интервал, через который повторяется применение инструмента, указыва-

ет дистанцию, на которую нужно переместить курсор, и определяется парамет-
ром Spacing (Интервал). Значение Spacing (Интервала) задаётся в процентах в
зависимости от диаметра кончика кисти. Диапазон возможных значений пара-
метра Spacing (Интервал) от 1 до 1000 %.
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Параметр Poundness (Форма) изменяет форму кончика кисти от круга до
линии (сильно сплюснутого овала). Значение 100 % соответствует кругу. Зна-
чение 0 % — линии. Промежуточные значения соответствуют овалам.

Параметр Angle (Угол) позволяет наклонить овал, чтобы сформировать
кисть для плоских мазков каллиграфического стиля.

СОЗДАНИЕ НОВОГО АППЛИКАТОРА КИСТИ

Новый кончик кисти проще всего формируется на базе выбранного в спи-
ске кистей текущего набора и изменённого вами аппликатора.

Команда New Brush Preset (Создание новой кисти) в меню палитры: 1щЛ

на кнопке > New Brush Preset (Создание новой кисти) — позволяет на-
звать новую кисть. Ещё проще дать имя созданной кисти, щёлкнув на кнопке

Create a new preset from this brush (Создать новую кисть из данной ) на

палитре Brush (Кисть) ниже кнопки  (рис. 25).
В обоих случаях открывается диалоговое окно Brush Name (Имя кисти),

показывающее созданный вами аппликатор кисти и содержащее только одно
поле Name (Имя) для ввода имени новой кисти. После введения нового имени,
следует нажать кнопку OК для закрытия этого окна.

ИЗМЕНЕНИЕ ЦВЕТА КИСТИ

УСТАНОВКА ЦВЕТА НА ПАНЕЛИ ИНСТРУМЕНТОВ

Выбор цвета в графическом редакторе Photoshop производится на панели
инструментов (рис. 26), причём можно определить как основной цвет (цвет пе-
реднего плана), так и цвет фона.

Рис. 26. Часть панели инструментов, отвечающая за выбор цветов переднего плана и фона:
1 — основной цвет (Foreground color); 2 — цвет фона (Background color); 3 — переключатель цве-
тов; 4 — установщик цветов по умолчанию

На панели инструментов программы предусмотрены четыре элемента для
управления цветом:

1. Основной цвет (Foreground color), или цвет переднего плана — это
цвет, который используют, применив инструменты рисования и редактирова-

ния: Кисть (Brush ), Карандаш (Pencil ), Перо (Pen ) и другие;

1

2

3

4
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2. Цвет фона (Background color) — инструментами Ластик (Eraser

) и Градиент (Gradient );

3. Переключатель цветов (switch color ) меняет местами основной
и фоновый цвета;

4. Установщик цветов по умолчанию (default colors): чёрный — ос-
новной, белый — цвет фона (как и изображено на рисунке 26).

Чтобы изменить основной цвет или цвет фона, нужно сделать 1щЛ на
нужном квадратике на панели инструментов.

ДИАЛОГОВОЕ ОКНО COLOR PICKER (ВЫБОР ЦВЕТА)

Когда вы щёлкаете на элементе выбора цвета (квадратиках 1-м или 2-м на
рисунке 26), открывается диалоговое окно выбора цвета Color Picker (Выбор
цвета) (рис. 27).

Рис. 27. Диалоговое окно Color Picker (Выбор цвета) для замены цвета:
1 — маркер выбора цвета; 2 — прямоугольник сравнения нового цвета с предыдущим; 3 — цветовое
поле; 4  — цветовая шкала; 5 — численные значения цветовых компонентов в моделях HSB, Lab,
RGB и CMYK

Новый цвет, который будет выбран в цветовом поле, отображается в
верхней части прямоугольника сравнения, расположенного правее цветовой
шкалы. Если щёлкнуть на кнопке ОК или нажать клавишу Enter, этот цвет бу-
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дет установлен как основной или как цвет фона в зависимости от того, как вы
вошли в окно выбора цвета из панели инструментов (1щЛ по квадратику 1-му
или 2-му) (рис. 26).

Цвет, который выбран на предыдущем этапе (предыдущий цвет), ото-
бражается в нижней части прямоугольника сравнения.

Цветовая шкала указывает цвет, который можно выбрать, в 8-разрядном
представлении. Это делается перемещением мышью треугольных ползунков,
находящихся по бокам шкалы или просто щелчком в нужном месте шкалы. На
шкале представляется 28 = 256 цветов или оттенков одного цвета в зависимости
от состояния переключателей, расположенных правее.

Цветовое поле отображает цвета в 16-разрядном представлении, то есть
охватывает 216 = 65 536 цветов или оттенков одного цвета. Вместе же цветовое
поле и шкала отображают более 16 млн. цветов (65 535 ´ 256 = 16 777 216).
Диапазон цветов, отображающийся на цветовых шкале и поле, зависит от со-
стояния переключателей, указывающих на выбранную цветовую модель.

Правее прямоугольника, отображающего текущий и предыдущий цвета,
могут появиться значки в виде треугольника и кубика.

Треугольник с восклицательным знаком внутри  сигнализирует, что
выбранный цвет выходит за пределы диапазона печати модели СМYК, а кубик

 — о несовместимости выбранного цвета с Web. Ниже каждого из этих
значков появляется квадратик, щелчок на котором изменяет текущий цвет на
ближайший совместимый (рис. 27).

В диалоговом окне Color Picker (Выбор цвета) цвет можно задать, введя
его шестнадцатеричный код в поле, расположенное справа от символа # (чита-
ется «диез» или «решётка»). Такой способ применяется, когда нужно приме-
нить определённый цвет.

ПАЛИТРА ЦВЕТОВ COLOR (ЦВЕТ)

Кроме диалогового окна Color Picker (Выбор цвета), цвет можно выбрать
на палитре цветов Color, открываемой командой Menu > Windows > Show
Color (Окно > Показать палитру цветов) (рис. 28).

На палитре цветов Color (Цвет) цвет можно задать путём ввода числовых
значений с клавиатуры, а также с помощью ползунков, расположенных вдоль
шкал цветовых компонентов. Шкалы с ползунками окрашены в цвета, подска-
зывающие, в какую сторону следует переместить ползунок, чтобы нужным об-
разом изменился цвет изображения. Щелчок на круглой кнопке со стрелкой

 в правом верхнем углу палитры раскрывает контекстное меню с команда-
ми установки режима (цветовой модели) и др.

Два квадратика на панели  отображают текущие цвета переднего пла-
на и фона. Щелчок на выделенном квадратике откроет окно Color Picker (Вы-
бор цвета). Внизу палитры отображается цветовая полоса для выбора цвета с
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помощью инструмента Eyedropper (Пипетка ). Щёлкните на нужном месте
цветовой полосы, при этом цвет выделенного квадратика изменится, а ползунки
на цветовых линейках изменят положение. На правом конце цветовой полосы

расположены белый и чёрный квадратики . Они служат для быстрой уста-
новки чистых белого и чёрного цветов.

Рис. 28. Вид палитры Color (Цвет) с открытым меню палитры

В левой части палитры цветов, ниже квадратов основного и фонового
цветов, могут появиться значки предупреждений о выходе из диапазона цветов,
аналогичные значкам в диалоговом окне Color Picker (Выбор цвета).

УДАЛЕНИЕ ЦАРАПИН И ПЯТЕН

ИСПОЛЬЗОВАНИЕ ИНСТРУМЕНТА CLONE STAMP (ШТАМП)

Если фотография сделана при неравномерном освещении, имеет погреш-
ности печати в виде тёмных или светлых полос, пятен, царапин, невозможно
откорректировать изображение так, чтобы все его участки были одинаково хо-
роши. Для коррекции такой фотографии следует по отдельности отредактиро-
вать области с различной яркостью, насыщенностью, гаммой и т. д.

Основной инструмент по удалению трещин, пятен или царапин — Clone

Stamp (Штамп ) клонирует изображение по образцу.
Выбрав данный инструмент, вы устанавливаете указатель в том месте до-

кумента-оригинала, откуда будет перерисовываться изображение, а затем де-
лаете Alt + 1щЛ. При этом происходит фиксация исходного положения указа-
теля, принимающего вид перекрестия. После этого можно отпустить клавишу
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Alt, установить указатель в то место, где будет создаваться новое изображение
(в месте царапины и т. д.) и начинать его перемещать при нажатой левой кноп-
ке мыши. Одновременно с самим указателем его перекрестие будет синхронно
перемещаться по объекту-оригиналу, указывая какое изображение появится на
месте обработки документа. Таким образом, область изображения, которая на-
ходится под перекрестьем, будет копироваться на новое место. Чтобы исправ-
ления были не заметны, следует брать образцы с разных участков фотографии.

ИСПОЛЬЗОВАНИЕ ИНСТРУМЕНТА
HISTORY BRUSH (ВОССТАНАВЛИВАЮЩАЯ КИСТЬ)

Другой способ «реанимации» фотографии основан на использовании
фильтра Gaussian Blur (Гауссово размытие) и инструмента History Brush

(Восстанавливающая кисть ).
Исходное изображение сначала максимально размывается с помощью

фильтра Gaussian Blur (Гауссово размытие): Menu > Filters > Blur > Gaussian
Blur (Фильтры > Размытие > Гауссово размытие) (рис. 29).

Рис. 29. Вид диалогового окна Gaussian Blur (Гауссово размытие)

Изменением параметра Radius (Радиус) или с помощью ползунка, распо-
ложенного на шкале ниже поля ввода, можно размыть изображение, то есть
сделать его нечётким (чтобы царапины максимально исчезли). Затем инстру-

ментом History Brush (Восстанавливающая кисть ) восстанавливаются
только участки изображения удовлетворительного качества. Таким образом, все
недостатки исчезают.

Инструмент History Brush (Восстанавливающая кисть ) позволяет
легко вернуть в прежнее (на момент последнего сохранения) состояние вы-
бранный участок изображения. В параметрах инструмента предусмотрена регу-
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лировка прозрачности (Opacity (Непрозрачность)). Значение этого параметра
лучше уменьшить при восстановлении мелких фрагментов изображения либо
при тонкой работе на границе фрагмента. Применение данного инструмента
тесно связано с палитрой History (События). Именно здесь фокусируются все
выполненные действия в процессе работы с данным документом.

ИСПОЛЬЗОВАНИЕ ФИЛЬТРА DUST AND SCRATCHES (ПЫЛЬ И ЦАРАПИНЫ)

Для удаления царапин и пыли также очень часто применяют фильтр Dust
and Scratches (Пыль и царапины): Menu > Filters > Noise > Dust and Scratches
(Фильтры > Шум > Пыль и царапины) (рис. 30).

Рис. 30. Вид диалогового окна Dust and Scratches (Пыль и царапины)

Фильтр избирательно действует на изображение, сглаживая лишь те уча-
стки, на которых нет резких переходов цвета и тона. Таким образом, детали и
границы остаются достаточно резкими, а мелкие артефакты уничтожаются.
Dust and Scratches (Пыль и царапины) прекрасно подходит для коррекции ста-
рого фотоматериала, особенно полутоновых (чёрно-белых) фотографий. Но не-
умелое применение этого фильтра удаляет мелкие детали изображения, унич-
тожая текстуру предметов.

Диалоговое окно фильтра имеет две шкалы с ползунками и два дубли-
рующих их поля ввода. В поле Radius (Радиус) определяется область, в кото-
рой выявляются отклонения яркостей (и цвета, если корректируется цветное
изображение). Чем больше установленный радиус, тем большая область усред-
няется, и тем самым из неё удаляется множество деталей, так как фильтр не в
состоянии отличить царапину от нужной небольшой детали. Чаще всего ис-
пользуется значение Radius (Радиус) в 2 пиксела.
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Величина параметра Threshold (Порог) задаёт разницу в цвете или тоне,
после которой программа меняет изображение. Чем меньше порог, тем большее
количество пикселов размывается, а чем выше, тем более тонко действует
фильтр. Наиболее приемлемым является значение Threshold (Порог), равное 6–
7 пикселов.
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